WARNING

The present user manual is the very first **DRAFT distribution**. It should be treated as so.

It contains incomplete sections and/or minor errors here and there *(and maybe more than just Ånglish errors & typo)*.

**COMMENTS AND CORRECTIONS ARE WELCOME!!!**
I will do my best to implement these in the final version. Many thanks in advance for your help and your understanding!

[Julien.allaz@colorado.edu](mailto:Julien.allaz@colorado.edu)
*(valid until summer 2018, new email address to be communicated later)*

*May the probe be with you, young microanalyst!*

*Julien M. Allaz – February 15th, 2018*
# 1) Table of Content

1) Presentation of the JEOL-8230 .......................................................................................... 1-1
   1.1) Hardware ................................................................................................................... 1-1
      1.1.1) Electron gun: W vs. LaB6 .................................................................................... 1-1
      1.1.2) Wavelength Dispersive Spectrometers (WDS) .................................................. 1-1
      1.1.3) Energy Dispersive Spectrometers (EDS) ............................................................ 1-3
      1.1.4) SE, BSE, and CL detectors .................................................................................. 1-3
   1.2) Software .................................................................................................................... 1-4
      1.2.1) Computers ......................................................................................................... 1-4
      1.2.2) JEOL computer: PC_SEM and PC_EPMA ......................................................... 1-4
      1.2.3) Probe for EPMA & Thermo EDS computer ....................................................... 1-12
      1.2.4) Software versions ............................................................................................. 1-17
      1.2.5) Software licenses & offline reprocessing ......................................................... 1-17

2) Before your analysis day: sample preparation & coating .......................................... 2-1
   2.1) Requirements before your analysis session ............................................................. 2-1
   2.2) Sample preparation and coating ............................................................................ 2-3
      2.2.1) Sample preparation ............................................................................................ 2-3
      2.2.2) Carbon or metal coating .................................................................................... 2-3

3) Start your day: checks & sample loading ................................................................. 3-1
   3.1) General status of the microprobe .......................................................................... 3-1
      3.1.1) Vacuum ............................................................................................................. 3-1
      3.1.2) High voltage and beam current ........................................................................ 3-1
   3.2) Sample exchange ..................................................................................................... 3-2
   3.3) Calibrating the electron beam ............................................................................... 3-6
      3.3.1) Filament saturation (W-filament only) ................................................................. 3-6
      3.3.2) Column Conditions .......................................................................................... 3-6
      3.3.3) Beam alignment: Condenser lens ...................................................................... 3-7
      3.3.4) Beam aperture alignment .................................................................................. 3-8
      3.3.5) Beam alignment: Objective lens ....................................................................... 3-10
      3.3.6) Beam stabilizer ................................................................................................. 3-10
   3.4) Navigate in your sample .......................................................................................... 3-10
      3.4.1) Using the stage control ...................................................................................... 3-10
      3.4.2) Using the “Stage Map”, “Step Control”, or stage coordinates ......................... 3-11
      3.4.3) Using the optical image ..................................................................................... 3-11
      3.4.4) Using the electron image ................................................................................... 3-11
      3.4.5) Using “Picture Snap” ....................................................................................... 3-11
      3.4.6) Focus, focus, focus ............................................................................................. 3-12
   3.5) Start & end of your day ............................................................................................. 3-12

4) JEOL software “EPMA” ............................................................................................... 4-1
   4.1) Getting SE, BSE, TOPO, or CL images ................................................................ 4-1
      4.1.1) Generalities ....................................................................................................... 4-1
      4.1.2) Imaging multiple signal .................................................................................... 4-4
      4.1.3) Cathodoluminescence imaging ....................................................................... 4-5
      4.1.4) Image annotation ............................................................................................. 4-5
      4.1.5) Reviewing acquired images ............................................................................. 4-5
   4.2) Additional features in PC_SEM ............................................................................. 4-6
      4.2.1) Operation settings ............................................................................................. 4-6
      4.2.2) Comment about the “Freeze” mode ................................................................ 4-7
      4.2.3) Step Control & Stage Maps ............................................................................. 4-8
   4.3) Additional features in PC_EPMA ............................................................................ 4-9
   4.4) Maintenance .......................................................................................................... 4-9
      4.4.1) Restart and emergency shut down .................................................................... 4-10
      4.4.2) Starting up the instrument ................................................................................ 4-11
      4.4.3) Troubleshooting ............................................................................................... 4-12

4.4.3) Troubleshooting ....................................................................................................... 4-12
5) Thermo EDS software “Pathfinder” ............................................................... 5-1

ADDITIONAL FIGURES TO COME LATER...

5.1) Generalities .......................................................................................................................... 5-1
  5.1.1) Starting the software...................................................................................................... 5-1
  5.1.2) Main acquisition modes & software panes ............................................................. 5-1
  5.1.3) Dead time & time constant ......................................................................................... 5-2
  5.1.4) Using Pathfinder offline .......................................................................................... 5-3

5.2) Spectrum – single point analysis .................................................................................. 5-3
  5.2.1) Tips & data processing ............................................................................................. 5-4
  5.2.2) Navigating in the spectrum pane ............................................................................. 5-4

5.3) Point ID ............................................................................................................................. 5-6
  5.3.1) Tips & data processing ............................................................................................. 5-7

5.4) Spectral imaging .............................................................................................................. 5-7
  5.4.1) Tips & data processing ............................................................................................. 5-8

5.5) Linescan ......................................................................................................................... 5-9

5.6) Particle analysis .............................................................................................................. 5-9

5.7) File structure & data export .......................................................................................... 5-9

6) Quantitative analysis with “Probe for EPMA” ......................................................... 6-1

SECTION NOT YET AVAILABLE...

7) Element mapping with “Probe Image” ................................................................. 7-1

  7.1) Preparing a map setup (Probe for EPMA) ................................................................. 7-1
    7.1.1) Element setting & standardization ................................................................. 7-1

  7.2) Acquiring maps (ProbeImage) ................................................................................ 7-4
    7.2.1) Spatial & analytical resolution, and mapping time ........................................... 7-4
    7.2.2) Preparing a map acquisition with Probe Image ............................................. 7-5
    7.2.3) Setting up the mapping area ............................................................................. 7-5
    7.2.4) Choice of elements (WDS Input) .................................................................... 7-6
    7.2.5) Analog signal, and column conditions ............................................................ 7-8
    7.2.6) Start the acquisition ......................................................................................... 7-9

  7.3) Example of mapping applications & settings ......................................................... 7-9
    7.3.1) Full thin section mapping ................................................................................. 7-9
    7.3.2) Quantitative mapping of simple phases ......................................................... 7-9
    7.3.3) Quantitative mapping of beam sensitive phases ............................................ 7-10
    7.3.4) Semi-quantitative mapping of monazite ......................................................... 7-11
    7.3.5) Mapping of trace elements ............................................................................... 7-11

8) Quantitative map treatment with CalcImage ...................................................... 8-1

  8.1) Required files and data ............................................................................................. 8-1

  8.2) Processing element maps ......................................................................................... 8-2
    8.2.1) CalcImage: processing the raw intensity maps .............................................. 8-2
    8.2.2) Exporting quantified images ............................................................................ 8-7
1) Presentation of the JEOL-8230

The JEOL JXA-8230 electron microprobe was acquired in 2015 (NSF-MRI grant EAR-1427626; PIs K.H. Mahan, J.M. Allaz, and G.L. Farmer) with cost-share support from CU Boulder. It was installed on March 14th, 2016, and was made available to researchers in September 2016 after months of testing from JEOL engineers Ken Stern and Chris Olmstead, and then by Julien Allaz. The instrument provides in situ microanalysis of solid materials (mineral, alloys, steel, ceramics, glasses, etc.), and is specifically designed to give rapid quantitative analysis of major and minor elements, and/or to push the limits on trace element analysis, down to the 1-10 ppm level.

The present user manual depicts the essential protocols for basic users, with information on analysis preparation and minimal troubleshooting. Refer to additional documentations provided by JEOL, Thermo Scientific, or Probe Software for details. The official JEOL manuals are in dark blue folders in the lab. Probe Software programs have powerful contextual help (press F1 in any window!), PDFs, and a web forum (http://probesoftware.com/smf/). A beta-version of the manual for Thermo Pathfinder is available on the computer desktop. For the theory on SEM and microprobe, see Goldstein et al. (2003) “Scanning Electron Microscopy and X-Ray Microanalysis”. https://link.springer.com/book/10.1007%2F978-1-4615-0215-9

1.1) Hardware

1.1.1) Electron gun: W vs. LaB6

Two types of electron sources are available at CU Boulder: a tungsten filament (W) or a lanthanum (or cerium) hexaborate crystal (LaB6/CeB6). The W filament is easier to handle, as it can be warmed up or cooled down quickly and is “only” $40 per filament. However, they need to be replaced every ~1,000 hours.

The LaB6 crystal presents the advantage of a longer life time (5,000 to 20,000 hours expected), and a higher brightness, which translates into a greater stability and a better spatial resolution. This electron source is preferred at CU Boulder. Unless stated by the lab manager, always assume a LaB6 crystal is in use.

WARNING: LaB6 crystal can be damaged if cooled down or warmed up too quickly. One crystal cost ca. $1,400. Therefore... (1) Cool down and warm up the crystal SLOWLY, and (2) NEVER ever PUSH the HV OFF button when using LaB6! If you accidentally did it, press back ON again, and call the lab manager.

1.1.2) Wavelength Dispersive Spectrometers (WDS)

The JEOL-8230 has 5 wavelength-dispersive spectrometers (WDS), one of which is equipped with four normal-size monochromators (J-type) for low-energy X-ray analysis (including light elements, Be to F), and four are equipped with large-area monochromators (L-type) that reach 2 to 3 times higher count rate. The latter is key for trace element analysis. The spectrometer configuration is as follows:

- **Spectrometer 1**: TAP, LDE1, LDEC, LDEB (P-10 counter)
- **Spectrometer 2**: TAP-L, PET-L (P-10 counter)
- **Spectrometer 3 to 5**: PET-L, LIF-L (sealed Xenon counter)

Large-area monochromators on spectrometer 2 to 5 offers 2-3x higher count rate than J-type, and should be preferred for minor and trace element analysis, or for element that can rapidly diffuse (e.g., F, Na). Due to the difference in detector type (P-10 vs. xenon detector), count rate of PET-L is higher on spectrometer 3 to 5 (xenon X-ray detector) than on spectrometer 2 (P-10 detector). It is NOT recommended to change (flip) the monochromator on a spectrometer during an analysis, as the reproducibility cannot be guaranteed.
Figure 1-1 Overview of the JEOL JXA-8230 at the University of Colorado, Boulder.

Figure 1-2 Top-view of the JEOL JXA-8230, and connections to JEOL and Probe Software / Thermo computers.
1.1.3) Energy Dispersive Spectrometers (EDS)

The microprobe is equipped with a 10 mm² UltraDry silicon-drift EDS detector from Thermo Scientific, with a guaranteed resolution at Mn Kα of 129 eV (measured on our instrument in August 2016: 126 eV). This new detector can reveal the major elements in a solid material in seconds, and can provide a phase map in a few minutes. In theory, the detector can detect X-ray from beryllium (Be) and boron (B). However, only sample extremely rich in Be or B and analyzed at low voltage might reveal a peak, as the ionization and collection efficiency of such light element are very low and very low energy X-ray are easily absorbed. Carbon is the first element to be clearly identified, and will be visible all the time when coating with carbon. Carbonate can be identified by a higher C Kα intensity compared to its intensity measured on C-free material.

1.1.4) SE, BSE, and CL detectors

The instrument is equipped with backscattered electron (BSE), secondary electron (SE) and panchromatic cathodoluminescence (CL) detectors. All together, these detectors offer four different imaging modes:

- **SEI**: SE detector, **topography** of the sample with **minor effect from composition**.
- **COMPO**: Total signal from the BSE detector, change in function of **composition** (brighter = denser).
- **TOPO**: In this mode, two opposite quadrants of the BSE detector are subtracted from the two others. The resulting image reveal the **topography only** of the sample with no compositional effect. However, the image resolution is not as good as the SEI (smoother image).
- **CLI**: Some materials will respond by emitting photon in the visible light spectrum. Such an emission is often caused (or inhibited) by the presence of some trace element, an activator (or inhibitor), or a crystal defect. This imaging mode is commonly used for zircon, carbonates, feldspars, quartz, etc. The detector is panchromatic, i.e. it will only collect the total light intensity on each pixel. A set of RGB filter can provide “true color” CL images, although it has been observed that such image tends to be too blue due to the poorer transmission efficiency of green and red.

![Figure 1-3 Four different imaging modes: SE, BSE, TOPO and CL.](image)
1.2) Software

1.2.1) Computers

The JEOL JXA-8230 is fully-automated, and operates with the JEOL software PC_SEM and PC_EPMA software. In addition, the programs “Probe for EPMA” and “Probe Image” from Probe Software along with “Pathfinder” from Thermo Scientific are installed on a second computer. These computers are never shut down, unless a maintenance is in progress. Logins and passwords will be communicated to you if you need it. The following software are commonly used (shortcuts on the desktop):

- **LEFT computer [JEOL]:**
  - EPMA (JEOL): launch PC_SEM and PC_EPMA (imaging, quantitative analysis and mapping);
  - Mouse Without Borders.

- **RIGHT computer [Thermo/PfE]:**
  - Pathfinder (Thermo EDS);
  - Probe for EPMA and related (for quantitative analysis);
  - Probe Image (for element mapping);
  - Mouse Without Borders;

The software “**Mouse without border**” is used to permit the use of a single set of keyboard and mouse on both computers. You should not need the other set of keyboard and mouse (on your right), and you should leave them below/behind the right screens and leave the mouse upside-down. When operating the instrument remotely (using TeamViewer), it is recommended to DEACTIVATE “Mouse without border” by making a right click on the orange icon 🎏 in the task bar and choosing “exit”.

In addition to the two computers, you will find on the desk two physical consoles, which are controlling the electron beam, the scanning mode, the imaging, and the stage X, Y and Z. These consoles are connected directly to the instrument. The large one on the left is the **Main Console**, and the smaller one on the right is the **Stage Console**. Most buttons on these consoles have their equivalent on the PC_SEM software.

**WARNING:** The computers should be strictly used for microprobe work. It is strictly forbidden to install programs or use it for private purpose (NO Facebook, NO Instagram, NO web surfing, etc.). Use your personal computer for this!

*If you need to transfer a file, use the dedicated USB shuttle on the probe desk.*

1.2.2) JEOL computer: PC_SEM and PC_EPMA

PC_SEM and PC_EPMA both run simultaneously. If these programs are not opened, click on the “EPMA” shortcut (in the taskbar, on the desktop, or in Windows menu). Usually, PC_SEM window is placed on the LEFT screen, and PC_EPMA on the RIGHT screen.

PC_SEM is the main JEOL interface used to generate, control, and alignment the beam of electrons, to control the stage, and to acquire images. Of main interest to a regular user, this interface is used for:

- Sample exchange;
- Electron beam adjustment (tilt, shift, astigmatism, focusing);
- Control of acceleration voltage, beam current, and beam size;
- Electron image acquisition;
- Beam stabilizer (rarely needed).
These main points are covered in some detail later in this manual. PC_SEM offers additional feature used by the lab manager for maintenance purpose that are not extensively reviewed in this manual.

The PC_EPMA interface controls the acquisition of data by the Wavelength Dispersive Spectrometer (WDS). It is a relatively simple interface, which offers data of good quality in simple and easy samples (silicates, metals, etc.). The software allows to obtain qualitative WDS scan, element mapping, or quantitative analysis. PC_EPMA also give access to the “Optical Microscope” (OM) video signal, and show the live status of the WDS spectrometer (position and current collected).

A few useful features are still regularly used in PC_EPMA, such as the ability to scan and identify all elements in a sample using the 5 WDS (= WDS scan). It also provides the ability to map areas defined by a rectangle or even an irregular polygon. For more accurate data and higher versatility in the analysis protocol, or in difficult materials (beam sensitive, peak interference issues…), the other software Probe for EPMA is usually preferred.

WARNING: This manual covers only the essential feature from PC_SEM and very few about PC_EPMA. The user should refer to the JEOL manual for more details. DO NOT use/touch what you don’t know about!

1.2.2.1) Overview of the PC_SEM interface

The interface is used to generate and align the electron beam, control the stage, perform sample exchange, and acquire images. The following summarizes in a few figures each four main components of the PC_SEM window. Refer to the chapter 3 and 4 for some detail protocols (e.g., for sample exchange or image acquisition), or to the JEOL Operations manual.

The essential and user-required functions of the PC_SEM program menu are summarized below. Refer to the JEOL manual for more detailed explanation on some specific functions not detailed here.

- **File, Edit**: See JEOL manual.
- **Function**: Shift between different view mode: full screen, one, or multiple electron images.
- **Image Processing**: See JEOL manual.
- **Tools**:
  - **Measurement**: activate tool to measure distances along X, Y, or diagonally.
  - **Probe Current Detector**: control of the PCD: IN (checked) or OUT.
  - **Contrast/Brightness**: open a window with values for B&C with sliders.
- **Setups**:
  - **Operation Settings**: Parameters for the software, including notably the step values for the Step Control navigation tool, and the scanning rate controls for quick, fine, and photo modes.
  - **User Manager**: Don’t even think about it. Nothing for you here.
- **Maintenance**:
  - **GUN/VAC**: Open the window showing the current status of the instrument vacuum and possible error report. This window should be open any time a sample change is performed.
  - **Self-diagnosis**: Set of self-testing routine, see manual.
  - **Maintenance**: Not for regular user, see manual.
  - **Energy Mode Schedule**: DO NOT SET ANYTHING HERE!
  - **Sleep Time**: Denise the probe does NOT sleep (except for maintenance). Do NOT use this feature.
- **Help**: … You mean this manual, right?
Figure 1-4 The electron microprobe laboratory, the two computers, and the main and stage consoles.

Figure 1-5 Overview of the PC_SEM interface. See text for detail.

1) Menus and main options (buttons) controlling the electron beam: voltage, current, Faraday cup, beam scanning mode, etc. Most of the functions on this menu are available on the main console, too.

2) Image display with legend.

3) Beam adjustment and imaging tools:
   (a) Image File: list of acquired images.
   (b) Observation conditions: beam current and size, controls, scanning mode, beam focusing, and SEM Monitor.
   (c) Extended Adjustment: gun bias, and filament heat.
   (d) Alignment: beam alignment tools.

4) Stage tools and guide:
   (a) Guide: some guidelines to use PC_SEM.
   (b) Navigator: library of acquired images used for navigation.
   (c) Step Control: fixed X, Y, and Z steps defined as a value in mm or a frame %.
   (d) Stage Map: list of saved position for navigation purpose and stage schematic.

5) Stage coordinates in mm (X, Y, Z)
Figure 1-6 Top menus and commands in PC_SEM, and equivalents on the Main Console.
(1) **MENU & MAIN OPTIONS**

The key controls of the electron beam and the scanning / spot mode are in the large buttons on the top of the screen. They can be split in two major groups (see also Fig. 1-6):

1) **Control for the electron beam generation:**
   - **Accel. Voltage**: Choose the required acceleration voltage (15 keV for most application). Change the voltage by steps of 3-5 keV, and wait a couple seconds between each change as the emission and beam currents stabilize (check values on the top).
   - **Emission / Filament current**: Current emitted by the filament (EMI, emission current, in μA) and current applied to the filament (FIL, in A).
   - **“EMI (FIL)”**: Switch for reading the emission current (EMI) or the filament current (FIL).
   - **Probe / Abs. current**: Current flowing through the Faraday cup (PCD IN = Probe current) or through the sample (PCD OUT = Absorbed current).
   - **“PCD IN (OUT)”**: Control for the Faraday cup (PCD = probe current detector):
     - \* PCD IN = Faraday cup inserted, probe current is read
     - \* PCD OUT = Faraday cup removed, absorbed current is read.

2) **Control for the beam scanning and image acquisition:**
   - **“Quick1/2”, “Fine1/2”**: Buttons for quick and fine raster modes. The setting can be changed in menu “Setups > Operation Settings [Image/Scan]”. Default: Quick2 (scan rate 2-3), Fine1 (8-10).
   - **“Freeze”**: Press **once** to acquire an image and freeze it after X passes (defined in Operation Settings; “Freeze” button blinks), or **twice** to freeze the image right away. When active (solid green), the image shown on the main screen is frozen, and most scanning functions won’t work (change signal, magnification…). It gets activated when the beam is set in SPOT mode (black screen, green cursor, “Scan” is OFF) or after an image acquisition (frozen image on screen). Reactivate the scanning mode or unfreeze the image by pressing the button “Freeze” button. When the multiple signal outputs mode is activated, the button “Freeze” will apply only to the selected image. Use the button aside (freeze with four squares) to unfreeze all images.
   - **“Auto” (focus)**: Do not use unless required (e.g., remote control). Activate auto-focus of the electron beam. It does not always work, and a manual focusing usually do a much better work. By default, only the electron auto-focus is performed. However, automatic astigmatism correction can also be performed (change option in “Setups > Operation Settings [Auto Function]”).
   - **“ACB” (Auto Contrast & Brightness)**: Adjust the brightness & contrast to reveal all features in the field of view without under- or over-saturated object. Use this button whenever the image is totally white or dark. For other cases, use the manual adjustment wheels on the right side of the main console (or change the value in “Tools > Contrast/Brightness”).
   - **“Photo”**: Push this button to acquire an image. The probe will automatically start to scan in Fine mode (1 or 2, depending on the choice in Operation Settings) and ask to save the resulting image.
   - **“Shift”**: When activated, it indicates that the beam is NOT centered. When using Probe for EPMA, it should always be DE-activated (get activated when click-and-dragging at >20k mag)!
   - **“Ruler”**: Activate/deactivate the measurement tools (for X, Y or X, Y and the diagonal).
   - **“Cursor”**: Show/hide the yellow cursor for the center. This cursor can be moved when you click-and-drag it! To make sure it is showing the center position, de-activate and re-activate it.
   - **“Spot”, “Scan”**: Indicator for spot or scanning mode. When “Spot” is active, a green cursor appears on the screen. When “Scan” is active (equivalent of “Prb Scan” on the console), the “Freeze” mode is automatically deactivated, and vice versa.
(2) **IMAGE DISPLAY**

On the top of the image display is a series of click-and-drag buttons used to change (a) the probe current, (b) the contrast and brightness, (c) the electron beam focus, (d) the magnification, and (e) the astigmatism correction. To use these functionality, click and hold a button; a yellow up-and-down arrow appears on the middle of the image. While still holding your click, move the mouse up or down to increase or decrease a value. This feature can be convenient for some, but most of the time the use of the buttons on the main console is easier. These functionalities do NOT work when using the probe remotely with Team Viewer (click-and-drag does not work). The RDC button reduces the scanning area. It is useful when performing a beam alignment, as the small image permits for a slow scanning rate at fast refreshing rate.

On the bottom part of the image display is a banner containing the image information. Info displayed in this banner can be chosen in the menu “Setups > Operation Settings [Photo & Print Data]”. When the image is NOT frozen, click on the signal name (SEI, COMPO, TOPO, or CLI) to change the signal output, or press the button “View” on the Main Console to switch between SEI ➔ COMPO ➔ TOPO ➔ CLI (➔ SEI…).

(3) **BEAM ADJUSTMENT AND IMAGING TOOL**

The first two tabs [Image File] and [Observation Conditions] are the most important one for your all-day microprobe work. Other tabs are only used for beam calibration purpose, or when restarting or shutting down the microprobe (something that you, as a user, should naturally NEVER do).

**Image File:** List all images in one folder, with the option to reload (and annotate) an image, to navigate back to the image position and/or to load the acquisition conditions (magnification, beam current, etc.).

**Observation Conditions:** Options to change the beam current and beam size, rotate the image (not recommended), change the beam focus (prefer the use of the focus knob), activate/deactivate the SE or CL detector, show the histogram, change image color set, brightness, contrast, or gamma. On the far-right side, the SEM Monitor shows a schematic of the microprobe, with indication of the current status (airlock vented or evacuated, where the holder [white rectangle] is, beam [green line], Faraday cup [PCD, yellow], and gun valve [inside the column]).

**Extended Adjustment:** As a regular user, you should not need to change anything in there. It offers the possibility to modify the heat of the filament (= current applied to the filament) by changing the saturation level. It also permits to find the optimum saturation point for a W filament (not to be used when using a LaB₆ crystal!), although this auto-saturation function may not always work. It is also used to change the bias of the electron gun (= the voltage applied between the filament/crystal and the Wehnelt cylinder to pull out the electrons from the filament).

*WARNING: LaB₆ crystal are very sensitive to abrupt changes in temperature! Do NOT change the saturation value or perform an auto-saturation when using LaB₆. In most cases, the saturation value is optimized when first installed, and only minimally changed throughout its lifetime (hopefully >5,000 hrs).*

**Alignment:** This tab is used when the beam need to be adjusted, either by changing the parameters of the condenser lens (tilt & shift), or of the objective lens (astigmatism correction). When using a W-filament, adjustments on the condenser lens (tilt & shift) is often necessary on the beginning of your day. Most of the time, a minimal tilt adjustment is required. When using a LaB₆ crystal, it is rarely needed. The astigmatism correction should be checked whenever the beam conditions are changed, especially saturation point, beam voltage, and large change in beam current.

(4) **STAGE TOOLS AND GUIDE**

This left section contains four tabs: Guide, Navigator, Step Control, and Stage Map. Most of the time, you will leave the tab “Stage Map” active, and sometime use the Step Control:

- **Guide:** Information and tips about the software.
Navigator: Allow to store temporarily several images in order to ease the navigation. I personally do not use this feature, and you should see the JEOL manual for more info.

Step Control: Navigate in your sample by a series of fixed step in mm or of frame in %. The value of displacement can be changed in menu “Setups > Operation Settings”. The motion by frame is convenient for particle search (e.g., with a motion of 80-90% of the frame per step).

Stage Map: List of position that the user can save, and schematic of the stage. Make a right-click on this latter to navigate to a position in the stage. Use the buttons on the right side of the stage map to add or delete points. The buttons below the list of positions are used to save points in a file, or upload a list of positions. P and Q points are reference point if the stage has some known position to calibrate and when the user upload a series of point (not used, and not described further her).

(5) STAGE COORDINATE

List of current stage position of the stage. To manually enter a coordinate, click anywhere on the X-Y-Z coordinate and modify the value in the stage coordinate window, then click move. The stage limits are X [-45, +45], Y [-60, +40], and Z [+8.5, +16.0]. There are two saved position: the home position right in the middle (X = 0, Y = 0, Z = 11 mm), and the exchange position in the bottom-center (X = 0, Y = -59.5, Z = 11 mm). The stage position increases from left to right or from bottom to top. However, when navigating in your sample, it will appear as if the coordinates are reversed with X increasing to the left and Y+ to the bottom. This is normal: when observing a feature situated on the top-right side of your sample, you need to move the stage to the opposite direction (left-bottom).

1.2.2.2) Overview of the PC_EPMA interface

This program will not be reviewed extensively in this manual; only a few tips and some necessary functionalities are presented. You should refer to the JEOL manual for more information. A quick overview is presented in Fig. 1-7. The buttons on the top are the main options for acquisition.

• “Quick” contains several analytical setups (called recipes) that the user can call back and modify. There is also a list for the last few acquisitions that can be called back, very convenient if you need to restart a failed run, or if you want to duplicate a set of analysis in a different sample.

The next 6 buttons modify the main screen (#3 in Fig. 1-7) to display the acquisition parameters:

- “Qual” for qualitative WDS scan, “Line” for linear traverse (usually qualitative), “Map” for element maps, “Quant” for point analysis, “Std” for standardization, and “OffQnt” for reprocessing data offline. Each window contains four major screen parts (color-coded; not shown in Fig. 1-7):
  - **Top bar:** just below the buttons, are used to set where the data are saved. You must choose a Path (on the right), and a name for your Project (on the left).
  - **Title area:** comment field to input additional information about your analysis, buttons to start the analysis now (Acquire), later (Add to Serial Analysis), or to save as a recipe. There is also a time estimate for your analysis.
  - **Electron optics condition:** (green pane) Define the voltage and beam current to use.
  - **Quantitative Analysis Condition:** (blue pane) Set of additional conditions of analysis, such as the oxidation state for each element, options for peaking and background acquisition, etc.
  - **Analysis Position Condition:** (yellow pane) Define your set of points to be analyzed.
  - **Analysis Element Condition:** (orange/red pane) Define the list of elements to be acquired on each spectrometer along with detector parameters.

Each section in this main screen has a little open square button. When clicked, the full set of options is shown.
“Start” will start the acquisition. When an analysis is running, the buttons “Stop” and “Monitor” will be available. “Monitor” will show the live results during an acquisition.

The buttons “Data”, “Serial”, “Periodic”, “Search” and “PHA” correspond to the tab in the bottom section of the screen (#4 in Fig. 1-7). The button “Std Mng.” will open a separate window containing the list of standards available in our laboratory, with referenced composition.

The last three buttons correspond to the tabs on the middle-right on the screen (#6 in Fig. 1-7).

The following are key functions you will need to (or want to) use:

- The **OM tab (#6 in Fig. 1-7)** on the middle-right section of the screen is the optical microscope. **You will need it ALL THE TIME!** Keep this window always visible. Click on the light bulb to turn ON or OFF the light. Click on the open square button (top-right of that screen) to detach this window and make it bigger. If the image is not visible even if the light is ON, detach the window and re-attach it back. It is also possible you are far away from the stage focus point. **When using TeamViewer, you must set the connection to be optimized for quality** to see the video signal. If you still don’t get an image, you the IP camera in the lab and zoom on the screen.

- The **Epma Data tab (#4 in Fig. 1-7)** is like an explorer window to navigate and open your results files in the JEOL program. All data are saved in the folder “EpmaData Project”; in this folder, there is also a folder call “JEOL Spectra”, which contains example of WDS scan in (pure/simple) materials.

- The **Peak search (#4 in Fig. 1-7)** with PC_EPMA is a bit faster than with Probe for EPMA. To use it, select the tab “Periodic Table”, click on an element, click on search in the right section, and select the X-ray line and spectrometer (along with peak scan options), and run a quick peak search.

- The **“Full Scan”** recipe in the **“Quick” menu** can be used to acquire a ca. 1.5-hour long WDS scan at high current (150 nA) in an unknown sample to identify all major and most minor elements down to
100-200 ppm. This feature is very convenient on the JEOL software, as the program will automatically identify all elements present in your sample (false positive remains possible, though).

- The **Spc Monitor (#5 in Fig. 1-7)** window should always be visible, as it gives a quick overview of the current position of each spectrometer.
- The **Chart Recorder (#5 in Fig. 1-7)** records either the count rate or the beam current over time (with measurement set at 0.2, 0.3, 0.5, 1, 2 or 3 seconds per step) is very convenient to use when checking for beam stability or change in count rate over time. Click on the open square button in the little Chart Recorder in PC_EPMA to detach the window and make it bigger.
- The **X-ray Meas. (#5 in Fig. 1-7)** can be used to quickly count for some specific element. Results are not recorded, just displayed on screen.

![Figure 1-8 Chart recorder in PC_EPMA.](image)

---

**1.2.3) Probe for EPMA & Thermo EDS computer**

**1.2.3.1) Probe Software: Probe for EPMA, ProbelImage, CalcImage...**

Probe Software is constituted of three main programs that are described in this manual:

- **Probe for EPMA (PfE)** for quantitative analysis;
- **Probe Image (PI)** for X-ray element map acquisition;
- **CalcImage** for quantification and processing of element map.

Additional programs not covered in this user manual are available, such as **Standards** (standard database), **Stage** (stage and spectrometer control), **CalcZAF** (ZAF matrix calculations), etc. Refer to the manual and contextual help from Probe Software for additional information.
**Overview of Probe for EPMA**

Probe for EPMA will be extensively covered in the next chapter. It is the most versatile and advanced software available to the microprobe community. It comes to a price: an apparent complexity with numerous options for acquisition and data treatment. The program consists of four main windows:

- **Log window**: Text window with program menus, and three buttons used to open the other three windows. All acquisition parameters, acquisition outputs, and results are displayed in this window.
- **Window “Acquire!”**: Used to define the acquisition parameters, and to acquire one point (standard, unknown, or WDS scan) one at a time; this later is required for very accurate positioning of better than 1-2 micron. It also displays the current status of the instrument: spectrometer and stage positions, timer and X-ray counts, analysis progress, etc.
- **Window “Automate!”**: Used to start a sequence of automated work using a list of digitized stage position (X, Y, Z) for standards, unknown, or WDS scan acquisition defined by the user. This is the most commonly way to analyze multiple points in large grains or domains, and when a stage reproducibility of 1-2 micron is acceptable. Currently, the software only allows to analyze in this order standards, unknown, WDS scans, and standards again.
- **Window “Analyze!”**: Used for post-processing the data, and to analyze the raw data (cps/nA) to obtain weight-% (or atomic proportion). Multiple options can be changed after the acquisition, such as peak interferences, background, matrix correction and MAC table to use, etc.

Key features of the “Acquire!”, “Automate!”, and “Analyze!” windows are shown in Figure 1-9 to 1-11. Most essential features will be further described later in this manual. For others, refer to the **Probe for EPMA contextual help**: activate the window with a feature / option you want to learn about and press “F1”.

Probe for EPMA has **no save button**. Everything you do will be automatically saved, except when acquiring an image (SE, BSE). **Only the raw data (counts) are saved**, and data must be processed using the window “Analyze!” or exported in a DAT file format (text file with tab-separated data).
Figure 1-10 Window Automate! of Probe for EPMA.
Figure 1-11 Window Analyze! of Probe for EPMA.
1.2.3.2) Thermo “Pathfinder” (EDS)

The program Pathfinder from Thermo Scientific is used for Energy Dispersive Spectrometry (EDS). The program offers multiple analysis options:

- **Single spectrum analysis**: place the electron beam over a feature to analyze, and get a spectrum.
- **Point ID**: acquire EDS data on multiple points selected on an electron image (SE or BSE).
- **Spectral Imaging**: Hyperspectral mapping and phase analysis: each pixel contains an EDS spectrum.
- **Line analysis**: qualitative scan along user-defined line. **Not reviewed here.**
- **Particle search**: identify particles using BSE intensity and/or composition. **Not reviewed here.**

![Pathfinder Interface](image)

**Figure 1-12** Overview of the Pathfinder interface and the 3 main modes: Spectrum, Point ID, and Spectral Imaging.
1.2.4) Software versions

Programs from JEOL and Thermo are rarely updated (once or twice a year at best). Last update from JEOL was from January 2017 (updates **PC_SEM 3.0.1.20** and **PC_EPMA 1.12.0.2** from June 2016). Thermo “Pathfinder” is relatively new with a first release in 2016. It is currently at **version 1.2.83**. There are still some bugs occurring randomly, which will hopefully be fixed over the next year or two.

At the time this manual is written, **Probe for EPMA** is at **version 12.1.x**. This program is fast evolving, with an update every couple week (if not sooner) to correct bugs or to improve/add new features. It therefore necessitates a regular update. Most feature presented in this manual *should* remain the same, though.

1.2.5) Software licenses & offline reprocessing

We have purchased a unique and non-shareable license for the JEOL software. Therefore you have to process your data acquired with PC_SEM or PC_EPMA on the microprobe computer (when the instrument is not in used…).

As a user of the EPMA lab at CU Boulder, you are allowed to get a copy of Probe for EPMA and of Thermo Pathfinder (EDS) for data reprocessing using your own computer. Windows 7 or later is recommended, and the compatibility with Windows 10 is NOT guaranteed. Instruction to download and install Probe for EPMA is found in **Chapter 6**. Thermo Pathfinder installation will be done by the lab manager on your computer as the installation files are on a DVD. **Contact the manager for more information.**

*Contact the lab manager if you encounter any recurring problems with a program or with the hardware.*
2) Before your analysis day: sample preparation & coating

2.1) Requirements before your analysis session

It is absolutely required that you come prepared and on time to your analysis session. Before reserving an analysis session, you MUST...

- **Prepare your sample** (mounting, polishing…). For accurate quantitative analysis it is mandatory to obtain a well-polished petrographic thin section or an epoxy round mount (1 or 1 ¼ inch).
- Document your sample, and get to know what information you will need to obtain:
  - **Locate the area(s)** to analyze; the field of view at the microprobe is just 3-4 mm!
  - **Locate the minerals or phases** of interest. If you have unknown phases to quantitatively analyze, you might need to book a first session for mineral identification using the EDS detector and to determine the major and minor elements to analyze. However, the use of a petrographic microscope (easy and free to use) is recommended whenever possible.
  - Take pictures of your sample is optional, but useful. Use a flatbed scanner and/or get a series of microphotographs! The sub-program PictureSnap in Probe for EPMA allows to load an image, and to calibrate it to the microprobe stage coordinate to ease the navigation. It is also possible to scan your entire sample stage prior to loading the samples, but this scan will be of low quality.
  - Determine the **list of elements** that need to be analyzed (in each different phases), and estimate if each element is a major (> 5%), minor, or a trace element (< 0.1%).
  - If the composition of the material is unknown, consider performing a WDS scan in the phase of interest to reveal all major, minor and some trace elements (down to 100-200 ppm).
- **Coat your sample**: carbon or metal (see Chapter 2.2.2). If you want someone else to do it for you or if you need assistance, contact the manager and drop your sample 1-2 days before your analysis day.
- **Set a plan for your analytical work** and discuss it with the manager or the assistant.

In addition, you should think about the exact analytical setting to be used. You can use the website [http://cub.geoloweb.ch/index.php?page=analysis_setting](http://cub.geoloweb.ch/index.php?page=analysis_setting) to help you with this process. **Schedule a time to discuss with the lab manager the ideal setting for your analysis:**

- Choose which **X-ray line** you will need to analyze:
  - Prefer high energy lines (e.g., K$_\alpha$ over L$_\alpha$; will depend on acceleration voltage used);
  - Prefer alpha lines over beta X-ray lines (or other) for maximum counting rate;
  - Only exception to the above two: minimize the problem of peak (and background) interferences; in case of a strong interference, prefer another X-ray line even if it has a lower intensity.
- Determine the **optimum acceleration voltage** based on the highest critical ionization energy of all X-ray lines to be analyzed (overvoltage >1.5x, ideally 2 to 3x), and on the desired spatial resolution (lower voltage = smaller analytical volume and larger beam size).
- Determine the **optimum beam current** and **beam size** depending on the material to be analyzed and the desired level of precision you want to reach. Some testing might be required. In general:
  - 20 nA and focused (0 µm) to 5 µm beam size for most classical application (major & minor elements in silicates, oxides, metal, etc.).
  - Lower current (1-10 nA) and/or larger beam size (5-20 µm) for beam sensitive minerals such as glass, alkali-rich phase, hydrated or hydrous phase, carbonate, phosphate, etc. For instance, 10 nA and defocused beam at 10 µm for glass and carbonates.
  - Adjust the beam size to the feature to be analyzed; beam should be smaller than this feature.
  - Use a higher current for trace element analysis (50 to 200 nA or more!).
- The analytical volume should be restricted to the phase of interest. You can run Monte-Carlo simulations with the program “Casino” to evaluate the analytical volume (download it here: [http://www.gel.usherbrooke.ca/casino](http://www.gel.usherbrooke.ca/casino)).
• **Testing prior to the analysis might be required to evaluate the ideal conditions**, especially when dealing with beam sensitive materials.

  Determine which **monochromators** you will need. For most applications, you will use TAP, PET, or LiF (from low to high energy). For low energy X-ray lines, you will need an LDEx. More than one monochromator might be available for a specific element (e.g., Ti Kα on LiF or PET), choice will depend on whether you need high spectral resolution (monochromator with the smallest 2d value) or higher count rate (largest 2d value).

  **Optimize your setting by minimizing the total analysis time:**
  
  • Split the elements to analyze over all available spectrometer and monochromators. If possible, do NOT flip the monochromators during the analysis due to problem of reproducibility.
  • Adjust the counting time for peak & background to optimize total analysis time.
  • Optimize the counting time so that each spectrometer finishes the acquisition at same time.
  • Use the MAN background correction for major to minor elements.
  • Use short counting time for major elements (10-20 sec).
  • Use longer counting time for minor and trace elements (60 sec and more).
  • Take into consideration of the potential beam damage. Damage is proportional to the beam current and size, and to the acquisition time! Sometimes you can only afford to analyze for 5 sec!
  • Balance the total counting time by considering what you really need between measuring multiple elements (>10), or obtaining precise analysis of trace or minor elements on a limited set of element. For high precision and low detection limit, a counting time of >2 minutes for one element is often required, along with the use of multiple spectrometer. It is impossible to do so on many elements.
  • Etc.

  **Optimize the PHA setting** for each spectrometer / element.

  **Identify possible peak or background interferences.**

  Choose a series of **adequate standard**. A list of available standards is on the lab website, and include a search feature. Each element constituting a material might requires a different standard. When multiple standards are available, choose according to these criteria:

  • High content of the element to be analyzed (most of the time >>10-20 wt-%).
  • Similar in nature (e.g., metal for steel, silicates/oxide for silicate; carbonates for carbonate);
  • Similar density and mineral structure;
  • Similar composition;
  • Oxidation state of the element to measure. For instance, prefer almandine garnet standard for Fe^{2+}, and hematite or magnetite for Fe^{3+}.
  • A standard you are already using for another element. This will help reducing the total number of standard to be analyzed, and thus the analysis preparation time.
  • Avoid using metal or pure element standard unless you are analyzing metals. There are exceptions to this rule, as not all element from the periodic table might be available in the form of a sulfide, oxide, or silicate.
2.2) Sample preparation and coating

2.2.1) Sample preparation

Electron microprobe analysis of high quality requires careful sample preparation. Samples must be solid, stable under vacuum, and mounted on either a petrographic thin section or a 1” or 1 ¼” epoxy mount. Sample of irregular size or oversized samples can be mounted under certain conditions. Ask the lab manager ahead of time to make sure your sample can be mounted.

It is your responsibility to obtain high-quality double-polished sample. Samples with poorly polished surface will result in bad analysis. Make sure to use low vapor pressure epoxy when mounting your sample (e.g., Buehler Epoxide, Epo-thin, Petropoxy 154, or Struers EpoFix).

A polishing wheel for fine polishing with 0.05 µm alumina powder is available in the basement for removing old coating. Ask the person in charge of the rock shop before using this polishing wheel. Avoid using acetone to remove carbon coating, as it can soften and dissolve the epoxy, too.

2.2.2) Carbon or metal coating

Most analyzed materials, especially geological samples, are non-conductive. It is therefore required to coat the samples with a thin (1-20 nm) layer of conductive material, usually carbon or other conductive metals (Al, Ag, Au, Pt, Os, Ir…). The refurbished Edwards 306 Auto is a dual-coater for carbon and metal. The coater is equipped with a UV plasma cleaner and a quartz oscillator to control the thin film thickness during deposition. The following summarizes the key steps in the coating process. Ask for assistance if you are unsure how to proceed, especially when using the coater for the first time.

**WARNING:** The coating used on both standards and unknown must be rigorously the same, especially when using metal coating, including the thickness of the thin film. A thickness discrepancy can lead to inaccuracy due to the stronger or weaker X-ray absorption effect. There are ways to correct for discrepancies in the material used or the coating thickness, but the correction has not yet been tested for accuracy.

**IMPORTANT:** Standards are very precious (and expensive). You should NEVER re-polish and re-coat any standard holder without approval & supervision from the lab manager!

Carbon coating is by far the most commonly used coating. It is a cheap, conductive, and has a low density and low X-ray absorption effect. It is producing chiefly one low energy X-ray line that will rarely interfere with your analysis. The thin film is usually 10 to 15 nm thick, and offers a low granularity.

In some applications, notably analysis of trace element or beam sensitive material, a metal coating might be required. Metals often have a higher conductivity, both thermally and electrically, compared to carbon coating, which helps to reduce beam damage effects. A thinner thin film around 1 to 10 nm is often sufficient. Metals have some disadvantages: (a) some metal can be one of the element to be analyzed (e.g., Al in most silicates), (b) heavy metals (Ag, Au, or Pt) will produce many X-ray lines, some of which can interfere with the X-ray line to be analyzed or with a background position, (c) metals have a higher X-ray absorption effect, which impacts the sensitivity of the analysis, (d) it will take more time to re-polish your sample to remove the coating (always use the finest polishing slurry, ¼ µm Al₂O₃ or better).

Some metals like aluminum can also oxidized immediately when exposed to the atmosphere. To counteract this effect, it is possible to perform a dual metal-carbon coating: the metal is deposited first (e.g., 10 nm Al), and a thin film of carbon (5-8 nm) is added to the top to prevent Al oxidation.
2.2.2.1) Preparing samples for coating

**WARNING:** Whenever you are touching a sample, you **MUST** wear gloves to prevent skin oil and other debris to get onto your sample. Greasy stuff and other liquids will prevent any coating to adhere properly.

1) **Clean your sample** in the ultrasonic bath (2-3 minutes) with ethanol or isopropanol to remove polishing residues, followed by a quick rinse in acetone. Final rinse with methanol. Use kimwipe to further clean the surface and remove the excess solvent.
2) Use compressed air (in the probe lab) to remove dust, and finish drying the sample in oven, on hot plate, or under vacuum, especially if your sample is porous.
3) **Mount the samples** on the round sample holder. Use the clips for the thin sections, or use the carbon double-tape for sticking epoxy mounts on the surface. Make sure your sample holds well, as they will be placed upside-down inside the coater.
4) **Carbon-coating only:** Add a piece of paper with your fingerprint on it as a monitor of the carbon thickness; the quartz oscillator does not measure accurately the carbon thin film thickness.
5) **Place the sample holder on the steel rod in the coater.** Watch out for the quartz oscillator! You might have to move it slightly to the left when placing the sample holder. Screw the holder in place.

See the text & figures in the following pages for sample mounting, location of carbon or metal coating supply, and for coating procedures.

2.2.2.2) Coating material and supply

The carbon coating material is normally situated on the table on the right-side of the table, with ample carbon coating rods, the rod sharpener, papers and sandpapers. Metal coating material is situated in the desiccator nearby, in a small cardboard box. If any of the material becomes unavailable or in short supply, contact the lab manager immediately.

**WARNING:** Like everything in science, coating material is expensive, especially Ag and Au. Use it wisely!

2.2.2.3) Coating procedure for carbon or metal (Figs. 2-2 to 2-5)

You will need to interact between the two interfaces of the Edwards 306 Auto. The **bottom interface** is a touch screen and controls the vacuum and start the process of plasma cleaning or coating (Fig. 2-3). The **top interface** is NOT a touch screen, and is used exclusively for the coating procedure (Fig. 2-6). Both carbon and metal coating follows similar procedure. The guidelines below highlight the differences in each procedure.

**WARNING:** Right after coating, the evaporation sources are VERY HOT, and will immediately burn you! Allow 10-15 min cooling (at atmospheric pressure) before preparing the source for another coating series.

6) Hold the evaporation source with one hand, and unscrew the bolt holding the carbon (or metal) evaporation source on the gold-colored rod (using the wrench if necessary) with the other hand. Release the source from the rod and leave it on the bottom of the coater chamber.
7) Unscrew by hand the 2nd bolt in the back, and take the evaporation source out of the coater.
8) Prepare the evaporation head:

   a) **CARBON evaporation source** (Fig. 2-4):
      i) Unscrew the two carbon rods of the evaporation source. There are two sets of screw for each rod; **the set of screws on the spring-side of the evaporation head has one defective threaded hole, don’t force it and unscrew only the other one.**
      ii) Prepare the new rods:
         1) Use sand paper + paper to make one side of the short rod shiny and flat.
(2) Use the automatic pencil sharpener to make a 5-6 mm long point.
(3) Supply of rods is available on the table to the right of the coater.

iii) Mount back the carbon rods. Fix first the short carbon rod with the flat surface on the non-moving part of the evaporation head. For the pointy carbon rod, insert the rod and retract the spring (put it under tension), then screw it in place.

b) METAL evaporation source (Fig. 2-5):
   i) Note which metal source is currently mounted (colored paper near the coater door), and unscrew the top screws to release the currently mounted tungsten (W) filament.
   ii) If this is not the metal you need for your coating:
       (1) Find the other W evaporation filament you need, usually inside the Petri dish in the coater.
       (2) If you don’t find it, take a new W-filament (inside the desiccator, in box “Coating supply”).
       (3) Place back W-filament you do NOT need inside the Petri dish. Do NOT put together the Al coated W-filament and the Ag coated W-filament, as they look very alike!
   iii) Double check you are using the appropriate W-filament. AVOID CONTAMINATIONS, the aluminum and the silver evaporation head looks very similar!!! Leave the one you do NOT need in the Petri dish inside the coater.
   iv) Cut a piece of the thin wire of the required evaporation material; Ag, Al and Au are currently available in the box “Coating supply” in the desiccator (Fig. 2-2). Wrap the thin wire of metal regularly around the W-filament (back-and-forth):
       (1) Used W-filament will have residue of the coating metal, and so you usually don’t need to add to much (nothing to 10-20 cm)
       (2) New W-filament might require a little more, as some of the metal might soak into the W-filament… maybe 30-50 cm?
   v) Place back the W-filament on the evaporation head. Screw it back carefully, as the filament gets really brittle when old and can easily break (if it does, start over with a new one).

9) Place back the evaporation head (carbon and/or metal). Screw by hand the bold in the back, and lightly with a wrench in the front. Make sure the evaporation head is centered and do not touch the other one.
10) Make sure that the O-ring of the coater door is clean and in place. Close the coater door.
11) Press the “Pump Off” button on the top interface to start the pumping sequence, and make sure the pressure decreases right away (quickly down to < 500-600 Torr). Do NOT use the manual valves!
12) Wait 15-20 minutes until the high vacuum is reached, around high to low 10⁻⁶ Torr (low 10⁻⁵ range acceptable for carbon coating, see Figure 2-3). When ready a message “System OK…” on the top of the bottom interface appears on the top of the lower screen.
(a) Carbon coating supply and tools.
(b) Example of sample loading of a thin section and an epoxy mount for carbon coating. Make sure the samples hold well, as they will be up-side-down in the coater.

Figure 2-1

(a) Metal coating, and (b,c) supply. Currently available: Al, Ag, Au.

Do NOT use paper (fingerprint method) when coating with metal!

Figure 2-2 Carbon and metal evaporation.
Figure 2-3a Bottom interface of the Edwards Auto 306 (touch screen) controlling the vacuum, etching process, and enabling the coating procedure.

Figure 2-3b Pumping sequence when pumping down (or venting).

Figures 2-4 & 2-5 (next two pages) Preparation of evaporation sources: carbon (2-4) and metal (2-5).
Figure 2-4 Mounting evaporation head for CARBON.

(a) Remove the carbon evaporation head.

(b) Remove both used carbon rods. Polish the flat side of the short one.

(c) Put the small flat carbon rod approximately in the center. Sharpen the other carbon rod to a 6–8 mm point. When loading the sharpened rod, make sure to put in under tension by holding the spring in position with one hand and loading the rod with the other hand.

(d) Remount the evaporation head, and make sure it is centered.
Figure 2-5 Mounting evaporation head for METAL.

(a) Remove the metal evaporation head from the coater (same as carbon evaporation head), and remove the cache cylinder (bolt on the side). Cut a short piece of metal wire; the amount you need depends on how much is left on the used filament.

(b) Unscrew the top screws slightly, and carefully remove the W-filament. A used filament is brittle and can easily break!

(c) Wrap the metal wire around the middle section of the W-filament (back and forth), to cover 3/4 of the spring-like section. Space it regularly across the filament.

NOTE: in this example, the W-filament is old, and has been deformed. A new one is shaped like a spring. New filaments are available in the coating supply box.

(d) Remount the W-filament on the evaporation head. If you use a new W-filament, you will have to bend one side, otherwise you won’t be able to put back the cylinder cache.

Put back the cylinder cache, and center it.

(e) Remount the evaporation head and center it.

If you need to mount both two evaporation heads (C+metal), center both of them, and leave 1-2 cm spacing between them.
When the high vacuum has been reached, you can run the plasma cleaning process (optional, recommended for metals), and finally the carbon or metal coating process. See Figures 2-6.

13) Turn the two main electrical switches to the required setting. Switch 1 on the bottom-left is for the selection of the evaporation type and is labelled [A-B, C-D]. Switch 2 on the top-right is for the voltage selection and is labelled [HV, LV]:
   a) PLASMA cleaning:
      i) Switch 1 – doesn’t matter;
      ii) Switch 2 to HIGH voltage [HV].
   b) CARBON coating:
      i) Switch 1 to [C] (or [D]);
      ii) Switch 2 to LOW voltage [LV].
   c) METAL coating:
      i) Switch 1 to [B] (or [A]);
      ii) Switch 2 to LOW voltage [LV].

14) Optional, recommended for metal coating: Proceed to the plasma cleaning:
   a) Switch the black toggle button on the top-right to “HV”.
   b) Enter the required “Etch Time” in seconds. Default is 60 seconds.
   c) Press “Etch Enable” (➔ [green]) and then “Run Off” (➔ turns [green] & change to “Run On”) to start the process. A needle valve is opened to equalize the pressure around low 10⁻¹ Torr, and the UV plasma cleaner is activated shortly after.
   d) Wait for the message “Process Complete”, and validate it.
   e) Press again “Pump Off” to re-activate the pumping sequence. After a short while (up to a minute), the rough pumping will start, and then the high vacuum (when reaching the low 10⁻² Torr).
   f) Wait until the vacuum reaches at least the low 10⁻⁵ Torr for carbon coating. For metal coating, a better vacuum around 10⁻⁶ Torr is desirable.

15) On the top interface, check the currently selected coating process on the top of the screen, e.g. “Carbon Layer 1 of 1” in white. If the select process is not the appropriate one, modify it:
   a) Click on “Process Menu”. If one of the menu listed below is not visible, you must cycle through the different menus pressing the button “Next menu” (top button).
   b) Use the control knob to select the desired process: carbon, silver, aluminum, or aluminum + carbon. Currently selected process will have an “Edit…” button; others will show “Select” instead.
   c) Validate your selection by clicking “Select” (button text changes to “Edit…”).
   d) The Edit menu in “Process Menu” defines important parameters regarding the coating process. You do NOT need to change any value, except maybe the final thickness. Refer to the Table 2-1 for a list of currently used parameters. To change a value:
      i) Select the entry to modify using the control knob.
      ii) Enter editing mode by clicking “Edit” or on the control knob.
      iii) Turn the control knob to change a value.
      iv) Validate your choice by clicking “Enter” or on the control knob.
   e) NOTE: you can access the parameters of the metal used in the “Film Menu > Edit…”. You do not need to change anything here, unless you need to ADD a new material not yet defined. If you need to do so, refer to the PDF manual of the Inficon deposition controller for additional information, it contains notably the density and the Z-factor of other coating metals (required parameters for the thin film thickness monitor).

WARNING: Do not change any parameters under the “Process Menu” or “Film Menu” without telling the manager. If you change something, set back the parameters to the value it was when you first arrived!
   f) Click on “Main Menu” to return to the main screen, and double-check that the right process is shown on the top of the screen.

16) Make sure that the high-vacuum has been reached (low 10⁻⁵ to mid-to-high 10⁻⁶ Torr), and that the console indicates “System OK….”
a) *Carbon evaporation process: – READ ENTIRELY BEFORE PROCEEDING!!!*

i) Double-check switches are on [C or D] (bottom-left switch) and [LV] (top-right switch).

ii) **Press “Run On” button.** If you are running a dual metal-carbon deposition, you do not need to press Run On (it should already be activated). The coater will start a sequence to check the vacuum, and then will enable the option “Transformer Enable” to permit the evaporation process. At this point, use the top interface to control and monitor the carbon deposition.

iii) The process should start in “Manual” mode, identifiable by the warning “Attention: Min. Power” and a white square surrounding the “Power%” reading. If this is NOT the case and you see the “Power%” going up, immediately press the “Auto/Manual” button to return to manual mode, and set back the “Power%” to 0 using the control knob.

iv) Clean up the rods (warming up): Use the control knob to increase the “Power%” to around 15-20%; the rods will start to glow orange-red (watch through the coater window). If not, increase the power a little bit more. It corresponds to an amp reading of around 1.5 A. *There is a small delay of a few seconds between changing the power% and seeing the current increasing.*

v) Wait a few seconds and monitor the vacuum in the chamber: it might degrade slightly as the carbon rods are degassing adsorb water and other particles. The rod is considered “clean” when the vacuum return to its initial value (or after 5-10 sec if no pressure change).

vi) Turn back the Power% to 0.

vii) Click the button “Start Layer”; if you don’t see it, press “Next Menu”.

viii) Increase **RAPIDELY** the power to around 35-38%. The rods will turn bright white. **Do NOT look straight at the rods, as it might damage your eyes!** Instead, look at it at a low angle. You will need to multitask rapidly here, monitoring simultaneously different things:

   1. **Monitor the vacuum reading.** It will apparently degrade (heat effect), but should remain in the $10^{-5}$ Torr range.
   2. **Monitor the deposition rate.** At first the value will be significantly negative, as the thin film monitor warms up. This is “normal” (well, not really, but live with it). Just wait. At some point the rate will go positive, you should reach around 0.5 to 1.0 Å/s rate. If the rate appears to remain low, keep increasing SLOWLY the Power%. There is no optimum value, as it varies for each rod; optimum “Power%” is usually high (38-42%) at the beginning, and then lower (35-38%) when the rods get consumed.
   3. Shortly after you see the deposition rate increasing, monitor the paper with your fingerprint by looking up through the coater window. When 10-15 nm of carbon is deposited, you should start seeing a faint fingerprint. The actually thickness reading on the deposition controller appears to be **WRONG** for carbon coating. In my experience, a “good” coating will read 4 to 5 nm on the controller.
   4. **Monitor the rods by looking at it at a grazing angle.** The rods should **NOT** sparkle, but should be bright white. Briefly before these sparkles, you will usually observe a faster increase of the deposition rate to 1 or 2 Å/s. **If you see sparkles, you MUST reduce the power right away:**
     a) Lower the “Power%” down to at least 30%.
     b) Increase back **SLOWLY** the “Power%” to around 35%; continue increasing the power until the deposition rate returns to 0.5-1.0 Å/s.
   5. Keep going until the rods is completely consumed; it might sparkle a last time, just before the rods contact finally break.
   6. Turn back the “Power%” to 0.
   7. Press “Next Menu” and click on the button “Reset”. This will end the coating process and returns command to the vacuum controller (bottom interface). Validate the “Process Complete” this message on this latter interface.
b) **Metal evaporation process:** – **READ ENTIRELY BEFORE PROCEEDING!!!**
   i) Double-check switches are on [A or B] (bottom-left switch) and [LV] (top-right switch).
   ii) **Press “Run On” button.** The coater will start a sequence to check the vacuum, and then will enable the option “Transformer Enable” to permit the evaporation process. At this point, use the top interface to control and monitor the metal deposition.
   iii) Metal process are run in automated mode. You should not need to do anything else, except watching it… However, keep an eye on the deposition rate. Ideally, the rate should remain lower than 5 Å/s. If you see the rate increasing too fast, press the “Auto/Manual” button and lower the “Power%” slightly using the control knob.
   iv) Wait until completion and validate the “Process Complete” message on the bottom interface.

c) **DUAL coating metal + carbon:** – **READ ENTIRELY BEFORE PROCEEDING!!!**

**WARNING:** Do NOT use a paper with your fingerprint like for a simple carbon coating process, when performing a dual metal-carbon coating. **The metal deposition process might BURN the paper!**

   i) The deposition controller show on the top which layer is active (“[…]. Layer 1 of 2”).
   ii) Set the switches to the desired setting for your first layer, usually [A-B] for metal and [LV].
   iii) Proceed to the first coating process (metal) as described above.
   iv) When done, the coater will switch to the next layer (“[…]. Layer 2 of 2”). If not, press the button “Next Layer” (click “Next Menu” if you don’t see this option).
   v) Wait a couple minutes to allow for the metal thin film to cool down and the vacuum to recover.
   vi) Switch the lower-left switch to [C-D] for carbon deposition.
   vii) Proceed to the second coating process (carbon) as described above.
   viii) When done, press “Reset” and validate the “Process Complete” message.

17) **Wait a couple minutes** to allow for the freshly deposited thin film to cool down.
18) **Press “Vent Off” button,** wait a 1-2 min (up to ~ 750 Torr pressure), and open the coater door. **The evaporation source(s) will be VERY HOT! Do not touch it, and let it cool down!**
19) **Remove your sample.**
20) **Close the door, and press “Pump Off” button** to leave the coater under vacuum (or load the next sample for another coating series). **DONE!**

---

**Figure 2-6a** Top interface of the Edwards Auto 306 coater: the SQC-310 deposition controller from Inficon.
Figure 2-6b Detail of the Film and Process Menus, and edit access.

Table 2-1 List of parameters used for the “Process” and the “Film” options (as of November 2017).
3) Start your day: checks & sample loading

3.1) General status of the microprobe

3.1.1) Vacuum

The microprobe works under high vacuum. When using a LaB₆ electron gun, a vacuum of better than $10^{-4}$ Pa must be reached, as LaB₆ (or CeB₆) crystals are easily contaminated. It is important to check the vacuum, especially just before, during and after a sample change.

In the JEOL PC_SEM, locate the menu “Maintenance > GUN/VAC”. In the GUN/VAC window, make sure that the vacuum reading in the chamber is in the low to mid $10^{-4}$ Pa, and almost an order of magnitude better in the gun (usually mid to low $10^{-5}$ Pa). See Figure 3-1 for the optimum pressure range (obtained after a few days of pumping). If the vacuum is NOT reaching these values, contact the manager. More details on the vacuum are presented in chapter 4.2.

![PC_SEM - top-left menu](image)

**Figure 3-1** Normal status of the high-vacuum, and of the electron beam.

3.1.2) High voltage and beam current

Before you come to the laboratory, you must determine the optimum voltage and beam current to use. Whereas beam current can be varied during the analysis, the acceleration voltage is usually fixed for the entire session. The optimum voltage for silicate is 15 keV, for sulfide with heavier elements or for any work on transition metal or high energy X-ray lines, precious metals, 20 to 25 keV might be required. For attempting
sub-micron spatial resolution, you will need a lower voltage around 5 to 10 keV. If necessary, discuss your needs with the manager who will help you to choose the best conditions for your analysis.

Regarding the beam current, an analysis at 20 nA will be ideal for most applications. However, you should reduce the current (1 to 10 nA) in beam sensitive materials such as alkali-rich materials (Na, K…), glass, hydrous (or hydrated) minerals, carbonate, phosphate, fluoride and chloride. If you seek for a higher precision (more X-ray counts), a higher beam current will be required (100-1000 nA). However, be aware that some minerals that are not damage at 20 nA, could well be at 200! Keep also in mind that a higher beam current will enlarge the beam diameter, although this is often not a big issue for work at ≥15 keV.

**WARNING: A LaB₆ gun is ALWAYS ON!**

NEVER press the “HV OFF” button on the top-left part of the in PC_SEM window! If shut OFF abruptly, the LaB₆ crystal can break (one crystal = $1,400)! If you accidentally pressed OFF, press immediately back the ON button, and tell the lab manager.

### 3.2) Sample exchange

Samples to be loaded in the microprobe should preferably be mounted either as a petrographic thin section or in a 1” or 1 ½” epoxy mount. Irregular or unconventional samples can be mounted, but often only once at a time. The maximum dimension is around 7-8 cm in size and no more than 1-1.5 cm in height. The samples have to be loaded using one of the three available shuttles:

1) Thin section and 1” round mount holder (up to 4 TS + 2x 1” –or– 9x 1” round mounts);
2) 1 ¼” mount holder (up to 6);
3) Universal stage for irregular and unconventional samples.

If you suspect some problem with your sample size (oversized thin section, irregular samples…), make sure to discuss with the manager BEFORE your analytical session.

Most of the time, the sample holder is left inside the microprobe, and therefore you should first remove the sample, prepare your new set of samples, and then load again the shuttle. When you are done at the end of the day, leave the holder either inside the probe or in the dessicator, and make sure to evacuate the airlock to help keeping the probe under high-vacuum. See instructions below and Figure 3-2 for unloading & loading a sample. Before proceeding to a sample change, make sure your samples are coated and ready to go.

**WARNING:** Whenever you manipulate a sample, a holder, or any part that is susceptible to go inside the microprobe, you MUST wear GLOVES (powder free) to minimize contamination! Gloves are available in the main room 125, near the large window of the clean lab.

As of December 2017, a custom-made manual switch control for the gun valve has been installed by JEOL on the side panel of the probe. On normal operation, the switch is on “AUTO”. During a sample exchange, the gun valve must be manually closed by switching it to “Gun valve CLOSED”. This helps to minimize contamination of the high-vacuum in the gun from the specimen chamber during a sample exchange. The JEOL software cannot sense the status of this switch, and therefore the gun valve in the SEM Monitor window will show open even when actually closed. However, you will see that the electron beam reading will be at 0 A, despite having an emission current (EMI) > 5-10 μA. After the samples have been loaded, ensure the vacuum has reached at least 5*10⁻⁴ Pa in the specimen chamber before switching the manual gun valve switch to “AUTO”.

1) On the “SEM Monitor” window in PC_SEM (bottom-right), push the button “Spec. Exchange” to move the stage in the sample exchange position (X=0, Y=59.5, Z=11). “EXCH POSN” on the side of the
When the stage is in the “Spec. Exchange” position, lift the exchange rod in the horizontal position up to its lock position, and slide the black handle towards the microprobe, up to the backstop.

3) Rotate the black handle counterclockwise to bring the white dot from the top to the LEFT position. The T-shaped end of the exchange rod is now grabbing on the sample holder. Pull back the black handle up to the end of the exchange rod (lock position). The sample holder is now inside the airlock.

4) Make sure the black handle is fully retracted, and push “Vent” on the side of the probe for 2 seconds (do NOT use the “Vent” button on the PC!). The gate will close, and the airlock will be vented.

5) Unlock the airlock hatch.

6) Open the airlock door at 90°. Remove the base plate AND the sample holder, and place them on the table. Close back the airlock to prevent any dust from entering. Remove the unwanted samples from the holder, and place them back in the desiccator (in their own box, if available).

7) Prepare your samples, and choose the appropriate sample holder: a mix of thin sections (up to 4) and 1” round mount (up to 9) OR 1 ¼” round mount (up to 7) OR universal mount. Write down in which slot each sample is put; use the sample holder prints available on the sample preparation table. Optional: Get a scan the holder with your sample using the flatbed scanner in the main lab room 125; this image can then be used in “Picture Snap” for navigation purpose.

8) Mount the sample holder on the holder base (heavy metal block). Pay attention to the orientation! Place the cut-corners towards the front, as depict on Fig. 3-2, step 8.

9) Load the sample holder and its base on the plate inside the airlock. Make sure to place the hook on the T-shape end of the exchange rod (see Fig. 3-2, step 9).

10) Inspect the O-ring and metal side of the door for dust/hair, dry clean if necessary, and make sure the O-ring is in place. Close the airlock, and lock the hatch of the airlock door.

11) Push and hold the button “Evac” on the side of the probe for 2 seconds. The scroll pump will start the rough pumping process (loud noise). Open the vacuum status window (menu “Maintenance > GUN/VAC”); the pressure in the Exchange Chamber (= airlock) should decrease steadily. When the pressure is close to the light blue level, the airlock gate will open. The Specimen Chamber pressure increases to low 10⁻² (this is “normal”), and should rapidly come back to the 10⁻³ Pa range.

12) Insert the holder inside the probe by pushing straight the black handle of the exchange rod. Do NOT touch the exchange rod itself! Push the handle all the way to the end. There should be little to no resistance when inserting the sample. If there is, stop right away and place back the shuttle in the airlock. You might simply NOT be in the exchange position, or something worse happens.

13) When you reach the backstop, rotate the black handle clockwise to release the holder inside the microprobe; the white dot moves from the left to the TOP position. Then, pull back the black handle towards you. When the exchange rod is inside the instrument, the probe might “beep”; it will stop as soon as you remove the rod. Once the black handle is fully retracted, fold down the rod by pulling the locking knob on the side of the airlock, and simultaneously pushing down the rod.

14) Unlock the exchange rod (black knob to pull on the left of the airlock), and fold down the rod.

15) On the JEOL computer, PC_SEM will pop-up a window asking to select the holder type loaded. Not all holder schematics are available; if yours is not available, choose the most similar one. The holder type can be changed later by clicking on the schematic of the stage in SEM Monitor. Check the vacuum reading in the sample chamber. For optimal operation, it should be in the mid to low 10⁻⁴ Pa range in the chamber; it can take 10-30 min, or longer if your sample is degassing (e.g., embedded in epoxy). Make sure to reach the 10⁻⁴ Pa range before turning back the manual switch for the gun valve to “AUTO”. A vacuum of low 10⁻⁴ is desirable for accurate quantitative data, and a high 10⁻⁴ Pa range is acceptable for navigating and images or EDS / qualitative data acquisition.
**Figure 3-2a** (part 1 of 2) Sample unloading and loading.
Step 9: Load sample holder and close airlock hatch.

Step 10: Inspect airlock seals and close back airlock.

Step 11: Pump airlock, check vacuum readings, wait for gate to open.

Step 12: Push handle to load sample.

Step 13: Rotate CW black handle and pull it back.

Step 14: Unlock and fold down rod.

Step 15: Select holder. Wait for Specimen Chamber to reach $P < 5 \times 10^{-4}$ Pa before opening the gun valve!

---

GUN/VAC: Make sure to reach at least $5 \times 10^{-4}$ Pa in the Specimen Chamber before opening the gun valve.

Optimum vacuum:
- Chamber: $< 5 \times 10^{-4}$ Pa
- Gun (SIP): $\sim 2 \times 10^{-5}$ Pa

---

Figure 3-2b (part 2 of 2) Sample unloading and loading.
3.3) Calibrating the electron beam

Calibration of the electron beam is easy and should be done for sure at the beginning of each day. You should repeat the beam alignment, especially the beam focus and the astigmatism, as soon as the image resolution appears to degrade, or when you change significantly the beam current, e.g. from 20 to 100 nA. The calibration is always done from the top of the column to the bottom:

- Filament heat [for W only];
- Electron gun conditions: acceleration voltage, bias, etc.;
- Condenser lens: tilt and shift;
- Beam aperture (physical alignment);
- Objective lens: focus and astigmatism.

3.3.1) Filament saturation (W-filament only)

**WARNING: NEVER change the filament saturation value when using a LaB₆ crystal!**

When using a tungsten (W) filament, it is likely that the previous user has turned down the filament saturation and turned OFF the High Voltage (HV). You will then first need to warm up the filament.

16) Click on the tab “Extended adjustment”. Press “ON” on the top-left side of PC_SEM to turn on the HV.
17) Set back the filament code (heat) to its previous value by check the radio button “Saturation”, and select “Fast” under “Auto Filament Setting”. Filament code should be between 110 and 140 for W-filament. Press the corresponding “Start” button to initiate the automatic heating of the filament.
18) Once a week, or whenever a new filament is loaded, perform an automatic filament saturation using the “Auto Filament Saturation” section to find the optimum saturation point: select “Saturation Curve and Probe Curr.” with a “Standard” search mode, and press “Start”. **NEVER PERFORM THIS WHEN USING A LaB₆!!!** Saturation of a LaB₆ is based on a factory-given optimum value and/or the emission pattern, and is perform by the lab manager only.
19) Wait until the beam reaches the optimum saturation point (auto-saturation) or the desired value.
20) If the beam is not stable after a while, check again the auto-saturation curve or wait longer. If instabilities persist, use the beam stabilizer (see Chapter 3.3.6).

3.3.2) Column Conditions

The column conditions are defined in the tab “Observation Condition” in PC_SEM or by using the corresponding buttons / switch on the main console. See Figure 3-3 for a description of the essential functions.

**Select the desired acceleration voltage** for your analysis using the list menu under “Accel. Voltage” in the top section of PC_SEM, or type in / modify the value under Accl. Voltage (kV) on the tab “Observation Condition”. For most applications (silicates, carbonate, phosphate…), a 15 kV acceleration voltage is optimum. If the analysis is focusing on transition metals or high energy X-ray ($\geq 8-10$ kV), a higher voltage of 20 or 25 kV should be used. To reach sub-micron spatial resolution, a low voltage $\leq 10$ kV is required. Whenever you change the voltage, the beam current will become unstable for a few minutes. Wait until it stabilizes, or use the beam stabilizer (see Chapter 3.3.6). Once set, avoid changing the voltage. For quantitative analysis, the standards and the unknown must be acquired at the SAME acceleration voltage.

The **beam current** is read on the top of the PC_SEM window. On the JEOL software, the current is expressed as amp (e.g., 20 nA = $2E-8$ A). It can be changed using the button in the section “Probe current” in
the tab “Observation Condition” of PC_SEM. The beam current can also be changed manually using the knob in the “Probe Current” section on the main console. If the button “Fine” is ON (or OFF), the value F/Fine (or C/coarse) of the probe current is changed; it is recommended to leave the “Fine” ON. For most common application and for navigation, a beam current of 10 to 20 nA is ideal. Avoid navigating on a sample at high current. For best image resolution, a smaller beam current (< 5 nA) can be used. The use of a higher beam current (50 to 300 nA) is recommended for minor and trace element analysis, for qualitative WDS scan, or for element mapping. When the tilt and shift of the condenser lens is aligned properly (see next section), a maximum probe current of >2 microamp is easily achievable.

When navigating in the sample, you should always leave the beam size (probe diameter) to 0.0 (focused beam), in order to obtain the sharpest image possible. Keep the current low for navigation (10-20 nA). Navigating at high current (>50 nA) is not recommended, especially in beam sensitive materials (carbonate, clay, etc.), as it can damage the sample. Whenever you prepare an analysis, you will have the possibility to define a different beam size (e.g., a larger 10-20 um beam size for beam sensitive materials).

3.3.3) Beam alignment: Condenser lens

The condenser lens is the main electromagnetic lens in the upper part of the column used to focus and center the electron beam, and to control the beam current. This lens needs a regular adjustment, called the tilt & shift corrections. LaB₆ are usually very stable once a clean and high-vacuum has been reached, and after a week at full power. However, a daily adjustment is recommended when the LaB₆ crystal is new or when the
instrument or the gun has been shut down for a while. For W filament, it is recommended to perform the tilt and shift alignment after filament saturation and after that the full beam stability has been reached. The tilt and the shift corrections must be performed iteratively, starting and ending with the tilt correction, and should aim at maximizing the beam current. WARNING: The refreshing rate of the beam current reading is slow, and can sometime takes close to 1 second! Be patient...

1) Expend the “Chart Recorder” window (top-right side of PC_EPMA) by clicking on the rectangle button:
   a) Select a fast refreshing rate (200 msec);
   b) Activate only the Probe current reading (deactivate the WDx channels, buttons on the bottom left);
   c) Start the chart recorder by pressing the play button. Stop and restart to clean the chart if necessary.
   d) Leave this window visible, you will use it to maximize the beam current.
2) Set a low beam current (1 to 20 nA) for the tilt correction.
3) Select the tab “Alignment” in PC_SEM. Click on the button “Tilt”. Alternatively, you can press the button “Align” on the main console (under the Alignment section) until “Tilt” is selected in the “Alignment”.
4) Turn alternatively the buttons X and Y under the Alignment section of the main console to modify the tilt values and reach a maximum probe current. You can also change manually the value in PC_SEM under “Setting Value” (do NOT press the “reset” or “reset all” button unless you want to start from scratch).
5) When the tilt is optimized, click “shift” (or press again “Align” on the main console).
6) Set a high beam current (> 100 nA) for the shift correction.
7) Turn X & Y under the Alignment section until the maximum current is reached.
8) Repeat the tilt and shift correction, until no significant change occurs when optimizing the tilt.
9) When done, press the “Stigmator button” or “STIG” on the main console (= Align OFF).

The JEOL program also has an automatic tilt and shift adjustment. This method is ideal when the filament is new (no idea where the optimum is). However, this method is time-consuming and in most case, a manual adjustment is quicker. To perform an automated tilt & shift adjustment:

1) Select the “Extended Adjustment” tab;
2) In the “Auto Gun Alignment” section, select either “from the present value” (for old filament) or from the center position (for new filament);
3) Select the range for the search: Narrow for a fine tuning, and Wide for a new filament or when the alignment is totally offset;
4) Optional: activate the Chart Recorder (probe current, with a 1 sec refreshing rate);
5) Press the “Start” button (the one on the right side, in the Auto Gun Alignment section!!!) and wait for a message of completion.

### 3.3.4) Beam aperture alignment

Once the condenser lens has been aligned, the optimum electron beam focusing point must be obtained by adjusting the lower part of the column: the beam aperture, astigmatism correction and electron focus point. For these adjustment, it is required to locate some small feature that can be used to optimize the image. Whenever you are adjusting the electron beam, you must first make sure that the stage is on focus (use the autofocus function). Make sure to choose a non-damageable area of your sample, as an extensive beam adjustment can cause some beam damage on the area you are scanning!

First, the microprobe is equipped with a beam aperture that let a certain amount of current to go through. Whereas SEM uses small apertures (10-100 um) for a larger field of depth, electron microprobe uses more often a large aperture (100-200 um) to let a larger amount of electron go through (= higher beam current). The aperture needs to be physically aligned (Fig. 3-4).
This alignment is normally done by the lab manager, and rarely need to be adjusted. Nonetheless, if you want to check or optimize the beam aperture alignment:

1) Move to a non-damageable area in your sample.
2) Focus the stage (Z; see the next section on how to navigate in your sample).
3) If the button “Freeze” is green, click on it.
4) Choose a low magnification, around 100x to 500x.
5) Remove the Faraday cup (button PCD IN ➔ OUT)
6) Choose the BSE or SE electron signal by clicking on the name of the electron image in the caption of the electron image window, and selecting COMPO (= BSE) or SEI.
7) Adjust the brightness and contrast, and locate an area that shows asperity or a good contrast.
8) Press the WOBBD button on the main console to activate the wobble mode. The BSE/SE image will appear to be twisting back-and-forth. The beam aperture is considered as centered when the wobbling effect is centered with only a minimal “twisting” effect, and no lateral / drift motion. If there is a drift, the beam aperture need to be manually aligned. To do so…
   a) Locate the beam aperture on the column (Fig. 3-4).
   b) Leave the beam aperture to position 1 (= large aperture for quantitative analysis to yield a maximum beam current). Positions 2 to 4 are only used for enhanced imaging.
   c) While still scanning on your sample, turn (slowly!) either the X or the Y axis knob, in order to center back the image and minimize the twisting and lateral motion.
9) Close the Faraday cup (PCD OUT ➔ IN).
10) Press the WOBBD button to deactivate the wobbling mode.
3.3.5) Beam alignment: Objective lens

There are two other alignments that need to be done on a regular basis, when the imaging appears of poor quality despite the stage being perfectly on focus or when changing the beam conditions (current, voltage). First, the electron must be focused on the surface of your sample (electron focusing), and the focus must be corrected for astigmatism. It is recommended to alternate between the electron focusing adjustment and the astigmatism correction:

1) Move to a non-damageable area in your sample
2) Focus the stage (Z; see the next section on how to navigate in your sample).
3) Zoom in to a high magnification, at least 2000x, and locate an area with some good contrast, such as a couple shallow scratches / fracture or cleavage (ideally interesting at 90° or close to), or a series of micron-sized particles or features.
4) Ensure that the tilt or shift correction is turned OFF by pressing “STIG” (= “Align OFF”).
5) Turn the large Focus knob on the main console to reach the sharpest image as possible.
6) Turn the knobs X & Y on the Alignment section of the main console to adjust the astigmatism correction. Optimum is reached when you obtain the sharpest image.
7) Alternate between the electron focusing and the astigmatism correction until you obtain the sharpest image. Sometime, the astigmatism correction is best adjusted when electrons are slightly defocused.

When the beam current is changed dramatically (e.g., from 10 to 200 nA), the electron focusing point should be adjusted. The astigmatism correction should roughly remain the same.

When using the probe remotely (e.g., TeamViewer), it is currently NOT possible to fine tune the electron focus point. The “Focus” entry in the tab “Observation Condition” is not accurate enough (would need 2- or 3-digit precision). The only way to focus is to use the “Auto” focus option (button “Auto” aside the “ACB” button on the top of PC_SEM). This function sometime works, sometime doesn’t… It might be necessary to test this on several areas (at medium to high magnification) until a good focus is reached.

3.3.6) Beam stabilizer

Prior to running any quantitative analysis, ensure the beam current is stable at least for the time of your analysis (use the Chart Recorder). In case of strong beam instability, the JEOL JXA-8230 is equipped with a beam stabilizer. It must be activated before starting any analysis on the JEOL or Probe for EPMA side.

1) Select the tab “Observation Condition” and adjust the beam current to the desired value.
2) Select the tab “Extended Adjustment” in PC_SEM.
3) Under the “Beam Stabilizer” section, select “Auto Repeat Mode” and click on “Tilt BST/CL BST ON”.
4) Wait until the two green lights above (Tilt BST and CL BST) turn ON.
5) The beam should now be stable.

3.4) Navigate in your sample

3.4.1) Using the stage control

There are multiple ways for you to navigate in your sample. First of all is of course the stage panel. This simple panel allows you to move along the three axis using “+” and “−” buttons (X and Y) or a wheel (Z). Note that (a) the X-Y stage motion will depend on the magnification (larger steps at low magnification), and (b) you can activate (or deactivate) the “C” button to activate the coarse (or fine) motion. The use of the rolling ball is not recommended: it is very sensitive and hard to use for accurate positioning.
On the top-right of the stage panel are two essential buttons: “AF” for autofocus, and “JOG” for jogging the stage. The AF function can fail if the stage is totally out of focus. This is a known program bug: only one end of the Z-stage position is checked if the sample is totally out-of-focus... Before using the AF option, you should adjust the Z-stage position to be close to the optimum focusing point. The “JOG” function is absolutely recommended when you need to save a position with a high stage reproducibility (better than ±2-3 um). When the stage is “jogged” it moves away from your point and come back to the stage position. If the position is the one you expect, you should expect a good reproducibility. If you observe a displacement, you should readjust the stage and jog again until you see a good reproducibility. Then only you can save the stage position.

3.4.2) Using the “Stage Map”, “Step Control”, or stage coordinates

For large motion (e.g., between samples), it is convenient to use the “Stage Map” in PC_SEM (tab on the top-right side of the program). The stage representation in this schematic view can be changed either when performing a sample change or by clicking on the stage representation under the section “SEM Monitor” of the tab “Observation Condition”. Make a RIGHT-click to move to a specific location in this Stage Map.

When searching for particle, or for regular “scanning” over the sample, you can use the “Step Control” in PC_SEM (tab on the top-right side of the program). You can then choose to move the stage (or the beam – not recommended) by a pre-defined “Step” or by “Frame”.

You can also click on the X, Y or Z stage value (middle-right on PC_SEM). This will open a window where you can manually enter a coordinate and move the stage to this position. When using the probe remotely, it is sometime necessary to use this feature to adjust the Z-focus point (e.g., when the sample is totally out of focus and the auto-focus function fails).

3.4.3) Using the optical image

In the OM Monitor window (in PC_EPMA), you can make a right-click on a feature on the optical image, and choose “Stage Move to Center” in the contextual menu to center this feature on the optical image. This navigation option is not very accurate. Do NOT refer to the optical image for centering the position to analyze. The optical center should be matching more or less the electron center, but a ±5 µm difference between both is possible. Also, some feature that can (inclusions, crack…) can be invisible on the optical image! Always rely on the actual electron center and use the BSE or SE image for fine positioning!

3.4.4) Using the electron image

When you are observing a live image (SE, BSE or any other mode), you can use the click-and-drag function to navigate across the sample. This is probably the most convenient way to navigate in sample over small distances. You can also make a right-click on a feature of interest, and choose “Stage Move to Center” to move the stage over the feature of interest.

3.4.5) Using “Picture Snap”

Picture Snap is a sub-program of the Probe Software suite that allows to upload a image (scan, microphotograph, electron/X-ray image, etc. JPG, PNG, or BMP format) and calibrate it to the stage coordinate. This is probably the most useful option for quickly identifying areas in your samples. A simple scan of the sample holder at 400-600 DPI using a flat-bed scanner can already provide enough detail to locate
a mm-sized area of interest in your sample. You can even prepare your own image (e.g., in Adobe Illustrator) to highlight the minerals or feature you need to analyze. See Chapter 6 on Probe for EPMA for additional information.

### 3.4.6) Focus, focus, focus...

**Pay special attention to the STAGE (optical) focusing.** Accuracy of electron microprobe analysis is very sensitive to the geometry (Rowland circle, Bragg’s law of diffraction). Always make sure you are on focus with the stage to obtain the sharpest image and the most accurate data:

- Use the **Auto-Focus function “AF”** on the stage control or on the OM (optical microscope) Monitor of PC_EPMA, or…
- Perform a **manual focusing using the stage control**, in which case you should ensure to **disable** the “C” [coarse] button on the stage control to permit a fine tuning, and use the “Jog” to ensure a good reproducibility.

**The stage is on focus when you see two dark-grayish diagonal lines on the OM monitor,** in addition to the black horizontal- and vertical-micrometer lines (see image on the right).

The AF function should work 99% of the time if you are close to the focus point (i.e., you can see some blurry to sharp diagonal lines on the OM monitor). **If you are totally out of focus** (diagonal lines not visible, dark screen, all blurry, etc.), the **AF function will fail 50% of the time**, as currently only one of the Z-stage limit is checked in the auto-focus function (bug reported to JEOL). If you intend to rely on the auto-focus function during an automated work, you MUST adjust the focus at least roughly BEFORE saving the position for an automated work. If the AF function fail, it will simply return to the initial (saved) position.

Make the distinction between the **stage (Z)** and the **electrons focusing**. Both need to be focused for optimum results (spatial and quantitative). You need to adjust the Z-position for every single point to be analyzed, whereas the electron beam alignment (as described in the previous section) is done at the stage Z-focus point for a specific beam condition. If this alignment has been done properly, you should only worry about the stage (Z) focusing.

**WARNING: Do NOT confuse the button “AF”** (on stage control or in OM Monitor window) **with the button labeled “Auto”** (on the main control and on the PC_SEM top buttons). The button “Auto” will attempt a focusing of the electron beam, which is often less good than human-made manual adjustment (see section 4.1).

### 3.5) Start & end of your day

Once your samples are loaded, that the beam has been aligned and set at the proper acceleration voltage and current, and that the current is stable, you can start analyzing or imaging your sample. Depending on the work to be done, refer to the following chapters:

- **Chapter 4**: Essential feature of the JEOL software, notably imaging and quick WDS scanning.
- **Chapter 5**: Thermo Pathfinder program for EDS analysis.
- **Chapter 6**: Quantitative analysis with Probe for EPMA.
- **Chapter 7**: X-ray element mapping with Probe Image, and quantitative images with CalcImage.

At the end of your session, make sure to remove your sample, and clean the lab space (paper, trash…). If nobody is working after you, leave the sample holder and its base in the desiccator. Leave the sample chamber
and the airlock under vacuum (with or without sample holder), and leave the sample exchange bar down. Make sure to transfer all your data. Depending on your work to be done, you might have data…

- On the JEOL computer, your **JEOL data** (images & analyses) are in C:\EpmaData\Project\Your name
- On the Probe for EPMA / Thermo computer, on several locations:
  - **Probe for EPMA & CalcImage**: C:\UserData\Your name
  - **Probe Image**: C:\UserImages\Your name
  - **Thermo EDS**: C:\ThermoEDS data\Your name

**WARNING:** Thermo EDS data can become excessively large (several GB per users), and therefore the data are regularly transferred to the backup drive “Data” (E:) to clean space on the C: drive. Ultimately, old works (2+ years) will be moved away from the Probe for / Thermo computer to liberate space. A copy should however remain on the external backup station (ask the lab manager for access).
4) JEOL software “EPMA”

The JEOL software can be used to acquire images, or WDS data (qualitative or quantitative). However, only necessary information on imaging and tips in PC_SEM and PC_EPMA are presented here, as this manual is more focusing on the use of Probe for EPMA, a more versatile software for quantitative spot analysis and X-ray element mapping. The following is presented in this chapter:

- Image acquisition with PC_SEM;
- Tips and tricks in PC_EPMA;
- Operation Settings (most important one);
- Maintenance;
- Additional tips.

Refer to Chapter 3 for information regarding the use of PC_SEM for sample exchange, beam alignment, setting the beam conditions, and stage navigation. For more information, refer to the JEOL manual (see the blue folders in the probe lab).

4.1) Getting SE, BSE, TOPO, or CL images

4.1.1) Generalities

The JEOL JXA-8230 offers four main electron imaging mode: Secondary Electron Image (SEI), Backscattered Electron Image (BEI or COMPO), Topographic Image (TOPO, subtract one side of the BSE detector from the other), and CathodoLuminescence Image (CLI). For imaging, you will use essentially the buttons on the main console or the buttons on the top of PC_SEM (both summarized in Fig. 4-1). To acquire an SE, COMPO, TOPO or CL image, the same procedure should be followed:

1) If not already done, select your own project folder for image acquisition in PC_SEM:
   a) Select the tab “Image Files”;
   b) Click on “Browse” to navigate to your folder.
   **NOTE:** You cannot create a new folder using the Image Files / Browse tab. You will need to use Windows Explorer to create your project folder within the folder “C:\EpmaData\Projects\Last name First Name (*)”. It is highly recommended to have a subfolder for each of your project and/or specific analytical session. (*) Your personal (or research group) folder.

2) Use an appropriate beam current (and voltage*); 10-20 nA recommended for most imaging, higher for CL.

3) Move to the area of interest.

4) Adjust the stage Z-position to be on focus. An approximate focusing is okay for navigation purpose; to obtain high-quality images, use the stage auto-focus (AF) function.

5) Set the instrument into scanning mode:
   a) If the FREEZE button is active, you must first deactivate it by pressing one of the “Freeze” button on the top menu of PC_SEM or on the main console. This will automatically activate the scanning mode (buttons “Scan” on PC_SEM and PRB SCAN on the main console are activated).
   b) Set the magnification to a low value, less than 100x (minimum is 40x).
   c) Choose the electron signal to display by either pressing several time on the “View” button on the main console, or by clicking the signal name (SEI, COMPO, TOPO, or CLI) on the image display.

6) Choose the scanning rate “Quick 2”, which is ideal for navigation. Fine 1 or 2 are used for photo.

7) Remove the Faraday cup by pressing the PCD “IN” button (on PC_SEM or on the main console).

* You should (must) choose one acceleration voltage at the beginning of your session, and NOT change it afterwards, unless absolutely necessary. Changing the acceleration voltage will induce some beam instability for 10-30+ min...
8) Adjust the brightness and contrast to reveal the feature of interest. Press the “ACB” button if nothing is visible, or adjust manually the brightness and contrast using the button on the main console. You can also see the contrast and brightness values by clicking on menu “Tool > Brightness and Contrast” in PC_SEM.

9) Press the button “Photo” to start the image acquisition. The scanning mode is switched to Fine 1 (or 2).

10) At the end of the acquisition, the JEOL software will ask you to save the image. Make sure to check the box “Export” in the “Save As…” dialog box if you want to keep the legend at the bottom of the image (with the signal information, date and time, scale bar, etc.).

If the image appears blurry, check first the magnification scale. At high magnification (> 1,000x), some level of blurriness is normal as you reach the instrument limitations. At 15 keV, 20 nA, you should be able to identify submicron features in the range of 0.2 to 0.4 µm. Otherwise, either the stage or the electron are not focused. Check first the Z-stage position (optical focus) and then the beam alignment (electron focus; see previous section). For the latter, a fine tuning of the astigmatism correction and the focus will be sufficient in most situations.
Four additional features are only available in the PC_SEM top buttons:

- **“Shift 0”** is the indicator of beam shift. It is deactivated most of the time. When active, it indicates the beam is deflected from its center. All Probe Software programs are NOT compatible with this JEOL feature and therefore you should always ensure the beam is NOT shifted (Shift 0 NOT available) before starting an analysis with Probe for EPMA or Probe Image. The beam shift can be set in the PC_EPMA program for a specific analysis. It can also be set (often accidentally!) when scanning at over 20,000x magnification. At this magnification, any click-and-drag mouse motion to move the sample position will actually result in shifting the beam and NOT the actual stage. Maybe one day this feature will become available with Probe for EPMA.

- **“Ruler”** is used to measure distance (horizontal, vertical, and/or diameter). Activate the ruler mode you need, and click and drag the green lines (or a corner) to move them and measure a distance.
“Cursor” is an indicator for the beam center (indicated by yellow cross). It should be used to ensure the proper positioning of an analysis spot. It is possible to move the position of this cursor by clicking and dragging it. If you accidentally moved it, and would like to see again the real center, simply de-activate the cursor and re-activate it.

“Full Image” allows to expand the BSE/SE image to the entire PCSEM window.

The default scanning rate for the pre-selection “Quick 1, 2” and “Fine 1, 2” along with the selection of the scanning rate to acquire a photo can be modified in the menu “Setup > Operation Settings”, under the tab Image/Scan. The recommended speed settings are 1 and 4 for “Quick 1” and “Quick 2”, and 8 and 10 for “Fine 1” and “Fine 2” (corresponding to ca. 30 and 90 sec, respectively). You can also opt for a multiple-pass photo, although it is usually not needed and set by default to 1. In the Photo Button section, choose “Fine 1” or “Fine 2” and the image size you want (1024 x 768 recommended). Except for CL imaging of very dim minerals, it is usually pointless to increase the speed to a value >10.

All detectors are sensitive to light. When using a high contrast, it is possible that the brightness of the screen will change when you navigate, notably in BSE (COMPO) mode, due to changes in the reflectivity of your sample. To avoid this issue, either set the contrast to a lower level, or switch off the light of the optical microscope (in the OM Monitor, click on the light bulb).

4.1.2) Imaging multiple signal

It is possible to see and take a simultaneous photo of up to four signals (BSE, TOPO, SE, and CL; Fig. 4-2). To do so, you must enter the “Comparison” mode by clicking on the button “Comparison” on the right side of PCSEM. You will then have new buttons on the right side for “Add”, “H-Dual”, “V-Dual” (horizontal / vertical) and “Quad”. The first mode allows to overlap two signals in a composite Red-Green view (rarely used). To acquire two images, choose H-Dual. Even if the image appears to be trimmed on the left and right side, both image will ultimately be acquired at the usual 4:3 ratio. Do NOT use the V-Dual mode, as the image will be trimmed up and down. Finally, the “Quad” mode is used to acquire simultaneously all four signals. You will likely have to select which signal to display on which screen, and adjust the brightness and contrast of each signal individually:

1) Click on one of the image you want to adjust the B&C to select it; a blue rim appears around the image.
2) Click on the “SEI” (or COMPO, or TOPO, or CLI) in the caption of the electron image, and select the signal to display in the list menu. If the list menu is not accessible, ensure the image is not frozen (click on “Freeze” or “Freeze all”.
3) Adjust the B&C using the buttons on the main console, or menu “Tool > Brightness/Contrast” in PCSEM.
4) Repeat steps 1-3 for the other signal(s).
5) Press the “Photo” button to start the fine scan acquisition. “Photo” and “Freeze” will blink and then turn solid green when the acquisition is over.
6) When the acquisition is over, a series of 2 (4) “Save As…” dialog box will pop up sequentially. The first “Save As…” correspond to the left image (top-left in Quad), the second to the right (top-right in Quad) image. For “Quad” mode, the two next correspond respectively to the bottom-left and bottom-right images.
7) To acquire a new image, ensure to unfreeze all images using the “Freeze all” button in PCSEM (the one with 4 little squares); the “Freeze” button will only unfreeze the selected image.
8) To return to the normal view mode, press the “Observation” button on the right-side of PCSEM.
4.1.3) Cathodoluminescence imaging

CL image acquisition is done the same way as BSE or SE. However, the detector is sensitive to light (duh!), and therefore is always turned OFF and only activated when needed. Why? Because most of the time, you will have the light of the optical microscope turned ON to be able to focus the stage… Note that there are safety in the system, and whenever you activate the CL detector, the OM light will turn OFF (and vice-versa). To activate the detector, press “ON” on the “CL Detector” section of the tab “Observation Conditions”.

4.1.4) Image annotation

You can annotate the acquired images by clicking on the menu “Edit > Text edit”. It will open a window with annotation tools. When you are done with the annotation, you must click the save button and save your annotation in a file (recommended: save location & file name as your original TIF file). Refer to the JEOL manual for additional information on this tool. I personally recommend using a much friendlier external image editor of your choice (GIMP, Photoshop, Illustrator, or equivalent). Note that Probe for EPMA (see Chapter 6) has the ability to save a BSE or SE image with the location of your quantitative analysis points.

4.1.5) Reviewing acquired images

When selecting the tab “Image Files”, PC_SEM will show you all images present in the selected folder. You can review the image by double-clicking on it, and click on “Horizontal” when the program asks you which orientation it should stretch the image. You can also navigate back to the position of your image by making a right-click on the image and choosing the option “Move this image point”. You can also opt to set back the instrument to the conditions of analysis of this image by choosing “Set Conditions”.

Figure 4-2 Observation vs. comparison modes for imaging in PC_SEM.
In the folder containing your image, you will find two files, a TIF image file and a text file. The text file contains the acquisition conditions, such as beam conditions, magnification, stage coordinates, etc. Both files should have exactly the same name to be recognized as a valid image by the program PC_SEM.

**4.2) Additional features in PC_SEM**

**4.2.1) Operation settings**

The “Operation settings” window regroups several tabs controlling the main software options; we will only cover the two tabs you might want to modify some parameters: “Image/Scan” and “Photo & Print Data” (see Fig. 4-3). Whenever you change a setting, remember to press the “Set” button (green box in Fig 4-3). The “Save” and “Load” buttons allow to save or load a file containing some default settings. If you want to reset the status to the default, load the most recent file labeled “Default YYYY-MM-DD”.

**WARNINGS:**

1. As a user of the microprobe you should NOT change anything in the following tabs: “Auto function” (control for the auto-focus and ACB), “Preset” (choices in the list menu for acceleration voltage, magnification and working distance), “Signal name”, “Stage/Beam setting”, and “Mouse Control”.

2. If you modified some option, you must re-set these options to their default value when your work is done! The next user will thank you!

**4.2.1.1) Image/Scan**

This tab controls the scanning rate of the different modes “Quick1”, “Quick2”, “Fine1”, “Fine2”, and “Photo”, along with the behavior of the “Freeze” button. Depending on the quality of the image you are looking for, you might need to increase the value of the scanning mode for “Photo” (most likely corresponding to “Fine1” or to “Fine2”). A higher number will slow down the scan rate and thus the total image time. You should not need to change the default on the Quick1 and Quick2 settings (1 and 4, respectively). A rate of 8 (~30 sec per image) is fine for general imaging. If there is too much noise at this rate, a value of 10 (~80 sec) will do it. You will rarely see any improvement beyond a value of 10, with the exceptions of CL images, and of low voltage or low current imaging, which are naturally noisier. For these exceptions, a value above 10 might be required (2+ min per image).

In the bottom-left part, you can modify the behavior of the “Freeze” button. You do not need to change anything here. Currently, the integration mode is active: if the “Freeze” button is activated, it will integrate 128 images (in Quick mode) or 8 images (in Fine mode) before freezing the image completely. Note that if you want to freeze an image immediately, you can always click twice the “Freeze” button (1st = activate the freeze; 2nd = stop it; click a 3rd time to un-freeze).

The top-right part is controlling the behavior of the “Photo” button (i.e., the mode used when you actually save an image). You must select which mode will be used, usually Fine1 or Fine2. In most case, it is not necessary to use the integration mode. However, for CL images, it might be beneficial to integrate several images acquired with a fast scanning rate, rather than using a slow scanning rate. Using the integration mode can actually help with problem of beam damage.

The Auto-save section of this tab contains the default setting for the behavior of the “Save As…” dialog. These options should not be changed.
4.2.1.2) Photo & Print Data

The other tab you might want to modify options is the “Photo & Pring Data”. This tab offers you the option to choose which information is being displayed in the legend bar of the Photo. Note that this legend will only be visible on the TIF image if you checked the check box “export” in the “Save as…” dialog box. We would certainly appreciate if you do not alter the label (default: “CU”) that marks where the picture was taken. Thanks!

Figure 4-3 Operation Settings, tab “Image/Scan” for changing the default scanning rates (Quick, Fine, Photo), and “Photo & Print Data” for selection of data to report on each saved image.

4.2.2) Comment about the “Freeze” mode

The “Freeze” mode is activated when in the electron beam is in spot mode, or whenever an acquisition (image or WDS) is over. You must click on it (deactivate it) to “unfreeze” the image, switch back to scanning mode, and enable again the live view on the screen. In some cases, you would like to just temporarily keep a
current view on the screen, without having to keep the beam on your sample (e.g., beam sensitive materials). To do so, press a first time on the “Freeze” button, to start stacking up a series of passes; the button freeze starts blinking. Press a second time to freeze the image; the “Freeze” button changed to solid green. You can then close back the Faraday cup (PCD OUT ➔ IN), and the image will still be visible on the screen.

### 4.2.3) Step Control & Stage Maps

The Step Control tab is used to move the stage by a fixed distance in mm, or by a fixed percentage of a frame. The step distance and frame percentage can be modified with menu “Edit > Operation Settings” and the tab “Stage/Beam Setting”

![Figure 4-4 Highlights on the “Step Control” and “Stage Map” tabs in PC_SEM (right-side of screen).](image-url)
4.3) Additional features in PC_EPMA

TO BE WRITTEN LATER

4.4) Maintenance

**WARNING:** Refer to the JEOL manual for more detailed information. HOWEVER, in contrary to what the manual states…

1. A LaB6 crystal **MUST** be cooled down and warmed up (saturated) SLOWLY (ca. 45-60 min total)!
2. **IGNORE** any suggestion from the JEOL manual about “daily shutdown and startup”! Our instrument remains ON all the time (under high vacuum, HV ON, filament heat at saturation, etc.). This is the only way to guarantee stability and longevity of a LaB6 gun.
4.4.1) Restart and emergency shut down

The instrument is usually NEVER shut off, and the filament heat is NEVER turned down (when using a LaB6 crystal). However, some situation will force you to shut down or restart the instrument. There are four levels of shut offs, and you always have to go in this order (or reverse) when shutting down (or starting up):

1) The **computer programs** (JEOL PC_SEM/PC_EPMA, Probe for EPMA, Thermo Pathfinder…);
2) The **Operation (OPE) Power** switch, which controls a microcomputer within the microprobe;
3) The **Vacuum Power** switch;
4) The **Main Power** switch.

The switches for steps 2 to 4 are found on the panel in front of the microprobe (behind a dark-brown plastic door).

You will rarely need to go further than the 1st or 2nd shut off to solve (minor) computer-related issues that is (a) restarting the computer programs (see *Chapter 4.4.1.2*) or (b) the microprobe microcomputer (see *Chapter 4.4.1.3*). The complete shutdown is only required when performing maintenance, or during an extensive power outage (> 30 minutes). A complete shutdown should be performed by the lab manager only. A complete shutdown easily takes 1 to 2 hours, and it will take one to several days to fully recover the vacuum and the beam stability.

**WARNING:** NEVER push any of the main I/O switches on the front panel (or any other button here) without discussing first with the lab manager (unless this is an emergency and you know what you are doing, see *4.4.1.3*).

4.4.1.1) Computer restart

The following procedure is good to be run once in a week, or at least monthly. This procedure can also be used as a first attempt in resolving a computer-related issue (most of the time related to a communication problem between both computers). Symptoms of communication issue can be extended “hanging time”, repetitive communication error messages, or worse a program regularly crashes or become unresponsive. In many cases, this is linked to some computer bug in the communication between the JEOL computer and the PfE/Thermo computer. In some other cases, a software update might help fixing things.

1) Exit ALL programs, in this order:
   a) RIGHT computer: Probe for EPMA, Thermo EDS, and any other program still opened
   b) LEFT computer:
      i) Run the “ResetEpma” command script to clean up all JEOL processes (shortcut on the desktop, or use the search field in the Windows menu). Wait for the execution of the script.
      ii) Close the JEOL program. If the software warns you that something is still connected, and asks you if it is OK to disconnect, just make sure that all programs are closed on the RIGHT computer, and click “Yes”.

   *In a last resort, force quitting the software causing problem using the Task Manager in Windows: *Ctrl + Alt + Delete* on the keyboard ➔ “Start Task Manager”, and end the hanging process.*

2) Shut down the RIGHT computer (PfE / Thermo).
3) Shut down the LEFT computer (JEOL).
4) Press the main I/O button of the EDS gray box situated between the two computers.
5) Wait 10 seconds and press again the button. The EDS box will be ready when the light turns green.
6) Restart the LEFT computer and log in (Probe Admin account; ask manager for pwd).
7) Start the JEOL EPMA program, and log in (account Manager1, pwd 1234).
8) Restart the RIGHT computer and log in. (Probe Admin account; ask manager for pwd).
9) Start the Thermo EDS program “Pathfinder”.
10) Start the additional programs you need, e.g., Probe for EPMA, Probe Image, etc.
4.4.1.2) Restarting the Operation Power

1) Turn down the filament saturation (very slowly with a LaB6, ~45 min).
2) While the filament cools down, exit all programs on the RIGHT computer (Probe for EPMA, Thermo...).
3) When the saturation reaches 0, the HV should turn OFF.
4) Exit the JEOL EPMA program.
5) Double-click on the desktop shortcut “ResetEpma” to clean up all JEOL processes.
6) Restart both computers.
7) Open the panel in front of the probe and set OPE POWER to OFF.
8) Wait a few seconds and set back OPE POWER to ON.
9) Wait 30 seconds. You will then here a “click” when the microcomputer of the instrument has fully rebooted. It is now safe to open again the JEOL EPMA program.
10) Warm up the filament up to saturation (very slowly!).
11) If using a LaB6, you will need to wait 2-4 hours to regain full stability. With W-filament, you should be ready to go in a few minutes to an hour. If necessary, use the beam stabilizer during the first hours of work (see Chapter 3.3.6).

4.4.1.3) Complete (emergency) shutdown

1) Abort any currently running analysis.
2) Close all programs EXCEPT the JEOL EPMA program. Force closing any program if necessary.
3) Turn down the filament saturation (very slowly with a LaB6, ~45 min, unless this is really an emergency).
   NOTE: in the worst case scenario that the JEOL EPMA program (PC_SEM or PC_EPMA) is becoming unresponsive, force quitting the JEOL program. Try then to restart it. If you still don’t have any response from the JEOL program, quit it again programs, and proceed directly to step 5.
4) When the HV is OFF (saturation at 0), exit ALL programs, starting with the RIGHT computer and finishing with the JEOL software.
5) Turn OFF the computer.
6) Open the panel in front of the probe and…
   a) OPE POWER to OFF;
   b) VACUUM PWR to OFF;
   c) MAIN PWR to OFF.
7) If shutting down the instrument for more than a day, close the gas bottles using the main valve on the top. Do NOT change the setting on the gas regulator part!

4.4.2) Starting up the instrument

Starting the instrument takes a long time, especially if it was fully vented or off for several days. Several steps are set on timer, notably the rough pumping (ca. 30 min), starting the turbo pump (15-30 min for reaching full speed and high vacuum), and the activation of the ion pump after reaching high-vacuum in the chamber (another 30 min or so). Proceed to the following:

1) Ensure there are no errors on the panel in front of the microprobe. Check also the Laboratory Journal for possible issues that the previous users had. If there is any error, it must be fixed first! If you think the problem is solved, but the front panel still display an error, try to push the “Error Reset” button on the front panel using a pen. If the error persists, contact the lab manager.
2) Ensure there is enough gas:
   a) Nitrogen (N2), required for venting and for the pneumatic valves);
   b) P-10 gas mixture (Ar + 10% methane) for the gas flow proportional counter.
3) Set the MAIN PWR to ON.
4) Set the VACUUM PWR to ON. The pumping sequence should start automatically, starting with the (loud) scroll pump, then the turbo pump, and finally the ion pump. The whole sequence can take 1 hour or more!
5) Leave OPE POWER to OFF!
6) Wait at least 30 minutes.
7) Set OPE POWER to ON.
8) Open the JEOL EPMA program and open the vacuum reading window (menu “Maintenance > GUN/VAC”). Wait until the “HV ready” light appears, which will indicate that a safe vacuum has been reached in the gun. A similar light “HV ready” is visible on the front panel.
9) If you are using a LaB6, you must reach at least the $10^{-5}$ Pa range in the gun before saturating the filament!
10) Proceed to the filament saturation, very slowly with a LaB6. If the gun was shut off for a long period of time (1 day or more), it is recommended to warm up the filament even more slowly by taking a 30-min break in the saturation process at one or two values before saturation (e.g., at $\sim$90 and $\sim$105).
11) Patience… It can take several hours and up to a full day for regaining full stability.
12) You will certainly have to adjust the gun alignment (tilt, shift, focus…) a few times over the next 24-48 hours, as the filament warms up and the vacuum improves.
13) When the vacuum is back to normal and the beam is stabilized, you can continue your work. If the beam current is not stable, use the “Beam Stabilizer” (in PC_SEM, tab “Adjustment”).

### 4.4.3) Troubleshooting

<table>
<thead>
<tr>
<th>The button PCD IN, or any other button on the main console, stops working, but the equivalent command on the screen works.</th>
<th>[Time to fix: &gt;4 hours] [experience level: low]</th>
</tr>
</thead>
<tbody>
<tr>
<td>The microprobe “brain” need to be restarted. If you can live with this handicap (i.e., only being able to use the screen button), continue your day. Otherwise, proceed to a restart of the instrument (see shut down section).</td>
<td></td>
</tr>
</tbody>
</table>
| 1) Turn down the filament saturation (**very slowly with a LaB6, ~45 min**).  
2) When the HV is OFF (saturation at 0), exit ALL programs, starting with the RIGHT computer, and finishing with the JEOL program.  
3) Open the panel in front of the probe and push OPE POWER to OFF.  
4) Wait a few seconds and press back OPE POWER to ON.  
5) Wait 30 seconds. You will then here a “click”. At this point you can restart the software, and warm up the filament.  
6) If using a LaB6, you will need to wait 2-4 hours to regain full stability. |

| When loading a sample, the required vacuum in the airlock cannot be reached, and the airlock ultimately timeout and vent again. | There is a leak, most likely on the door. Open the airlock, and carefully inspect the O-ring and the metal side for any scratch or dust. If necessary, remove the sample holder and use a dry kimwipe (or your clean glove) and the compressed air to clean it. Close and try again. |

| One of the microprobe program (PC_SEM, PC_EPMA, Probe for EPMA, Pathfinder…) becomes unresponsive and Windows suggest me to close it. | First, wait! The JEOL microprobe can be sometime sluggish in responding after a command has been sent (e.g., when performing auto-focus, when setting the beam current or moving a spectrometer…). Just wait a moment. If the program is still not responsive, force closing it. If the program in question is PC_SEM or PC_EPMA, you must close ALL OTHER programs FIRST. If the problem persist, you might have to restart the probe (see the shut down section above). |

| How can I see the emission pattern of a LaB6 to ensure my beam is well aligned? | Select the SE imaging mode. On the column mode, select EMP (stands for EMission Pattern) and adjust the brightness and contrast; use the ACB button if necessary. You should see a single spot, perfectly round and well centered. If the emission pattern is not centered or deformed, the beam must be re-aligned or the LaB6 crystal must be replaced. A similar emission pattern is visible when the ACB button is used. |
pattern can be observed also with a W-filament, although it will usually result in a broader and less well-defined disk pattern.
5) Thermo EDS software “Pathfinder”

5.1) Generalities

5.1.1) Starting the software

The EDS is controlled by the program Pathfinder. Only some essential features are presented in this manual, and you should refer to the Thermo Pathfinder manual for more details. To start, follow these steps:

- If not already running, start Pathfinder (icon on the desktop or in Start menu). The software generally opens the Faraday cup (PCD IN ➔ OUT; sometime it does not…); if this happens, push the “PCD” button to place back the Faraday cup (PCD OUT ➔ IN).
- Open an existing project folder or create a new one. If the program was already running, click on the “Project Explorer” icon (green folder on the button bar) or choose menu “File > Project Explorer…”. If you just started the software, the Project Explorer is the first window to show up above the main software window. Project folders are specific folder within the ThermoEDS Data folder where all your data will be stored. It is good practice to…
  - Create a “New Folder” (yellow) with your name (Last First) in the ThermoEDS Data folder;
  - Create a “New Project” (green) within your personal folder, with a simple name describing either your project or the date of today and short description. For a better organization, it is recommended to write the date in the format YYYY-MM-DD.

**WARNING:** Pathfinder does not control the Faraday cup (except when you start the software), or the choice of electron image signal. You will have to remove the Faraday cup before the analysis and place it back manually. When acquiring an image, you must first select the signal you need in PC_SEM first (SE or BSE, most likely BSE / COMPO).

5.1.2) Main acquisition modes & software panes

The software includes five different modes, which can be selected from the top-right side of the Thermo interface. Only the first three will be discussed in this manual, refer to the Thermo Pathfinder manual for details on the last two modes:

- **Microanalysis > Spectrum (S)** for single point analysis: obtain a single spectrum from the phase on which the electron beam is (in spot or scanning mode). Ideal for quick phase identification.
- **Microanalysis > Point ID (PS)** for acquiring EDS using a BSE image to target one or more areas of interest (using beam deflection). Acquisition can be done in live or automated mode, and is ideal for areas with several phases to identify, or to record an image with the location of the EDS analysis.
- **Microanalysis > Spectral Imaging (SI)** for scanning over an area and collecting a complete EDS scan in each pixel of the scan. This mode is often refer to as “hyperspectral mapping”. Results are basically an EDS element mapping and phase analysis using PCA (principal component analysis). Individual spectrum can then be extracted either from the identified phases, or from a selected area;
- **Microanalysis > Linescan** for EDS acquisition along a line (not discussed here; see manual).
- **Feature Sizing** > The newest add-on to the software, should permit particle search and chemical characterization of the particles. Not fully tested yet (not discussed here; see manual).

The software can be subdivided in 7 main panes, some of which are only available in a certain mode. This mode is indicated with its abbreviation (S, PS, or SI):

- **Image Pane (PS, SI):** Electron image, either BSE, SE or CL (selection must be done in PC_SEM);
Maps Pane (SI): Results of the spectral imaging: element maps, principal components, or phases. Each maps can be activate (map title in black) or deactivated (white) by clicking on it. If active, the map will be overlaid on the electron image.

Spectrum Pane (S, PS, SI): EDS spectrum in keV vs. intensity. In S and PS mode, it will display the currently selected point or area. In SI mode, it can be either the total spectrum, the spectrum of an identified phase or of a selected area.

Periodic Table Pane (S, PS, SI): elements are color-coded if they are present, absent, never or always identified, etc. The software automatically identifies the elements if the “Auto ID” under Spectrum Processing is active. For a manual selection, click on an element to change its status, or right-click to choose from a list of options.

Controls Pane (S, PS, SI): List of options for the acquisition (very top) and for the treatment of the data. Different options are available depending on the selected mode.

File List Pane (S, PS, SI): List of acquired spectra (S) or areas mapped (PS, SI: with sub-listing of each individual analysis or individual phases identified).

On the very bottom of the screen is the status bar, which indicates the currently recorded acceleration voltage, magnification, beam current, stored rate, time constant, dead time percentage, and take-off angle. Values are updated when the analysis is running. It is good practice to keep an eye on the dead time value (see below). The beam current is only properly measured and reported in the status bar if the “Measure Beam Current” button is activated! Otherwise the value reported is the last value read.

On the right side, in the controle pane, there are two green arrows. The top arrow (pointing horizontally) allow to detach the acquisition setting window. The arrow on the middle-right (pointing vertically) will minimize the control pane.

When hovering the mouse near the top-right corner of the Image, Maps, Spectrum, or Quantitative pane, a series of gray and black button will appear. These buttons allow you to expand one or two panes. You can for instance see only the spectrum, or the spectrum and the image, or image and maps, etc. You can also resize the pane by clicking and dragging the edge of a pane (this later was known to sometime bug and freeze the software, but I think they fixed it…). BTW, Thermo recommends using one of the Windows “Aero” theme mode for best experience and best layout.

5.1.3) Dead time & time constant

Any electronic device has a so-called “dead time”. It corresponds to the time required for the device to process an incoming signal. During this time, the instrument is unable to record another incoming signal – it is temporarily dead. A correction is applied to compensate for this loss, but if the rate is too high, the EDS saturates and the analysis efficiency and accuracy is affected. The Thermo Ultradry SDD EDS system has 10 different processing time available, also called “shaping time”, from 6.4 µsec down to 0.2 µsec. A short processing time can count up to a million X-ray per seconds (cps; rate 10 = 0.2 µsec), whereas a longer processing time can “only” collect up to 72,000 cps (rate 1 = 6.4 µsec). At 20 nA, a rate of 1 is appropriate. At 200 nA, a rate of 8 or more will be required. A longer processing time (low rate) will allow for a better spectral resolution, whereas a shorter time (high rate) will return a less accurate energy reading of the X-ray, and as a result the X-ray peaks will broaden.

It is best practice to test what appropriate time constant should be used before running your analysis. Simply place the electron beam over your sample at medium magnification (500-1,000x) and check what is the dead time. Ideal value should be < 40%. If you are considering using different current settings, you should test with the highest current (highest count rate). If you modify the time constant (rate) in the spectrum setting window, the new value will only be applied when you start an acquisition. In “Auto” mode the detector will automatically choose the appropriate rate.
For extremely high current applications, the EDS detector is equipped with a slit that can be manually switched to low or to high count rate, or to a closed position (for protection). It is found above the EDS detector tube (red knob). Left position is CLOSED, middle is HALF-OPEN, and right is FULLY-OPEN.

5.1.4) Using Pathfinder offline

As a user of the electron microprobe lab at CU Boulder, a copy of Pathfinder can be installed on your personal computer for reprocessing purpose. In order to use Pathfinder on your computer, you must run first a routine called “NSS DPP Simulator”. This program emulates an EDS detector. The executive file that run this program is found in “C:\Program Files (x86)\Thermo Scientific\Pathfinder\Service Tools\” under the name “SystemSIXSim.exe”. Run this program and leave it open. It is equal which “detector” you choose to emulate, this will not affect your quantitative results. You can minimize the window.

I have personally tested using Pathfinder offline on my personal computer (a Mac with a Windows virtual machine), and it works… somehow. The software appears to have a problem, but this might be because I am using a virtual Windows machine, so you may NOT encounter the following issue. When starting the software, the logo of the software appears but the program never fully opens. The issue appears to be related with the process “MCS Server” being launched by Pathfinder. You will have to open Windows Task Manager (keyboard [Ctrl]+[Alt][Del] ➔ Start Task Manager) and kill the process “TNMCSServer.exe” (description: MCS Server). This should “unfreeze” the software, and you should finally have the Project Explorer window accessible. Note that the SAME problem will occur again if you switch between the different modes (Spectrum, Point ID, Spectral Imaging…). Same here, you will have to kill again TNMCSServer.exe. Other than that, the software should work like a charm.

5.2) Spectrum – single point analysis

The spectrum is the simplest feature of the EDS software. It simply collects all X-ray received from whatever area (or point) the beam is on. It is commonly used to quickly identify a phase by moving the stage over the phase of interest, zooming in so that the scanning covers only the phase of interest, and start the acquisition. See also Figure 5-1. In more details…

1) Ensure you are in the right Project folder. Change if necessary.
2) Move to the area of interest.
3) In the control pane:
   a) Click on “Spectrum”.
   b) Type in the sample name (e.g., “MySample area1 Px1”; spaces are allowed).
   c) Click on “Experiment Setup” (gear-like button aside the “Start Spectrum”) and adjust the acquisition parameters (live time, max count, and cutoffs). Adjust the time constant depending on the count rate received.
4) Remove the Faraday cup and locate the grain to be analyzed.
5) Increase the magnification until the scan covers ONLY the phase of interest. Alternatively, once the beam is centered over the phase of interest, switch to spot mode by deactivating “Prb Scan”.
6) Leave the Faraday cup out!
7) Return to Pathfinder, and press “Start Spectrum”. The run will start with your acquisition conditions.
8) During the acquisition, the spectrum will be progressively enhanced (more and more counts) until either the required live time or the maximum number of counts is reached.
9) The “Start Spectrum” button will change to a “Stop” button with a “Pause” and an “Abort” buttons aside. The “Stop” button will stop and save the data, whereas the “Abort” button will NOT save the data (however the spectrum will remain visible until the next acquisition).
10) CLOSE the Faraday cup as soon as the analysis is over!
5.2.1) **Tips & data processing**

You can save a default set of acquisition conditions (time, cutoffs, time constant) in two user defined settings. After setting the conditions, click on the button “User Defined” and choose to save your current setting in User Setting 1 or 2.

On the right side of “Start Spectrum” is a tiny button with an up-side down triangle. When you click on it, you can select to run the acquisition using a set of predefined conditions: high throughput vs. high resolution, or the user setting 1 or 2.

The buttons on the bottom part of the control pane are used to treat the results:

- **“Spectrum Processing”** allows you to de-/activate the automatic element identification, and to process the data (force the automatic ID or obtain semi-quantitative results). In order to manually identify elements, you must uncheck this box, and then make your element selection. When checked, the software will automatically re-identify the peaks each time the sample is selected. If you activate the “Quant Setup” mode and click “Process”, the software will calculate a standard-less quantitative analysis. Such results are to be considered as qualitative in most situation and will only rarely be accurate. For true quantitative analysis, standards should be used. It is possible to do standard-based analysis with Pathfinder (radio button “Standardless” > “Standards”), but the software is currently not set up for this feature. However, it is common to use Probe for EPMA to collect both EDS and WDS data and thus perform standard-based EDS-WDS analysis.

- **“Spectrum Match”** allows to compare an EDS scan with a library of EDS scan to identify the mineral / phase type. A bug during a recent update of the software rendered the database useless, and the problem is currently being investigated. If it was working, pressing the “match” button should list a series of possible match, with a Chi-square value; a value below 10 is an acceptable fit; a perfect fit will have a value of 0 (zero). Currently, the bug always reports the first X entries with a Chi-square of -1.000…

- **“Spectrum Setting”** allows to modify the aspect of the spectrum window (linear or log scale, color…), and has options about which X-ray lines to show.

In the File List, you can use the button on the right side to (a) Rename, (b) Delete, (c) Compare, (d) Match, (e) Spectra Check, or (f) Info. The comparison mode is very useful when you need to compare two spectra that are apparently very similar but can be differentiated by their element peak ratios (or intensity):

1) Select a first spectrum to compare.
2) Click on “Compare” (button turns yellow).
3) The button Spectra Check is now available; when active, the background, residual and synthetic spectra (calculated by the software to match your spectrum) becomes available.
4) Click then on a second spectrum to compare with the first one.
5) You can choose to normalize the data. Providing the two (or more) spectra to compare have been acquired at the same current, normalizing to the live time will ensure a 1:1 comparison. In some other cases, you might find that normalizing to one of the element present in both mineral (e.g., Si) is useful, too. You can also multiply a spectrum by a factor or normalize to the maximum.
6) Click back on “Compare” to leave this mode.

5.2.2) **Navigating in the spectrum pane**

- **Double-click**: zoom out and return to the full view.
- **Click-and-drag (to the left, right, top or bottom)**: slide the spectrum and zoom in when approaching the low or high limit of the spectrum.
- **Mouse wheel**: place the cursor over an area of interest in the spectrum and use the mouse wheel to zoom in or out.
**Figure 5-1a** EDS Spectrum mode: important panes, acquisition parameters and processing options.

- **Spectrum:** X-ray counts vs. energy in keV
- **Acquisition setup and post-processing:**
  - Control
  - Rename...
  - Delete...
  - Compare...
  - Match...
  - Check...
  - Info...
- **Quantitative results:** Standardless analysis, not used at CU (see comments in text).
- **Periodic table:** click to switch between element status (identified, excluded...), or right-click to choose status.
- **File list:** Listing of acquisition results.
- **Experiment setup:** Set up the counting time or max count, energy cut offs, and time constant.
- **Automation:** Save positions and acquire them later. This option is not reviewed here (see Pathfinder manual).
- **Spectrum Processing:** Choose to identify the elements, or to quantify the results, and click Process. If the Auto ID is checked, it should be done automatically at the end of an acquisition.
- **Spectrum Match:** Compare your spectrum with a library and return a list of potential matches. Currently not working.

**Experiment Setup**

- **Start acquisition**
  - Enter a name before acquiring data.
  - Condition to end the acquisition after a fixed live time OR when a maximum peak count is reached, which ever comes first.
  - Default cutoffs: 100-150 eV, 20 keV
  - Time constant set depending on count rate:
    - Rate 1 for low current applications (<30 nA, <72k cps)
    - Rate 8-10 for high current (>200 nA, >500k cps)
    - "Auto" will force maintaining the dead time around 30 to 50%
    - For standard-based quantitative EDS analysis, use the SAME time constant on standards AND unknown.
5.3) Point ID

The principle of this mode is simple: acquire an image and click where you want an analysis. Compared to the spectrum mode, an additional pane is visible on the left side for the BSE or SE image.

1) Ensure you are in the right Project folder. Change if necessary.
2) In the control pane:
   a) Click on “Point ID”.
   b) Type in the sample name (e.g., “MySample area1 Px1”; spaces are allowed).
   c) Click on “Electron Image Setup” (gear-like button aside the “Start Image”) and adjust the acquisition parameters for the image. A quick image (fastest) with 2 frames at 1024 pixels is totally appropriate.
   d) Click on “Experiment Setup” (other gear-like button aside the “Start Spectrum”) and adjust the acquisition parameters: live time, max count, cutoffs, and time constant (rate).
3) On the microprobe instrument, in PC_SEM, move to the area of interest.
4) Remove the Faraday cup and locate your area of interest.
5) Choose BSE (COMPO) mode and adjust the magnification to fully cover the area of interest. The magnification should be high enough to be able to target accurately the smallest feature to analyze.
6) Adjust the brightness and contrast to see all the features of interest.
7) Leave the Faraday cup out!
8) Return to Pathfinder, and press “Get Image” to acquire the BSE image. Wait until completion.
9) Use the buttons below the BSE image to setup the EDS acquisition:
   a) In the list-button on the left, choose the style of acquisition: point or spot analysis, or scan over an area of interest (rectangle or polygon). You can also opt for the magic want which will automatically select an area showing the same BSE intensity (using a user-defined threshold).
   b) “Instant”: if this button is active, the analysis will be run as soon as you click on the image (live mode). If not, the point/area selected will be shown on the BSE image, and the acquisition will run only when you press “Start Spectrum”.
   c) “Cursor” will activate a red cross you can move across the image to get the X and Y coordinate and the intensity (of the BSE signal).
   d) When “Select” is active, you can select a point or area on the map to see the result or to delete it.
   e) To delete a point, select it and press [Delete] on the keyboard.
10) If you have selected your point without the “Instant” button active, press “Start Spectrum” to acquire all positions automatically using the setting defined in “Experiment Setup”.
11) During the acquisition, the spectrum will be progressively enhanced (more and more counts) until either the required live time or the maximum number of counts is reached.
12) After the acquisition, use the File List pane to see each individual acquisition.
13) Providing you do NOT move the stage, you can continue adding more points (to be acquired instantly or in automated mode), even after a first series of acquisition.
14) CLOSE the Faraday cup as soon as the analysis is over.

5.3.1) Tips & data processing

Like for the spectrum acquisition, you can save a default set of spectrum acquisition conditions (time, cutoffs, time constant) in two user defined settings, by clicking on the button “User Defined” and choose to save your current setting in User Setting 1 or 2. The same can be done for the image acquisition settings.

On the right side of “Start Spectrum” is a tiny button with an up-side down triangle. When you click on it, you can select to run the acquisition using a set of predefined conditions: high throughput vs. high resolution, or the user setting 1 or 2.

The buttons on the bottom part of the control pane are used to treat the results:

- “Spectrum Processing / Match / Setting” – see Section 5.2.1.
- “Image Setting” allow to adjust the brightness, contrast and gamma of the electron image. Although useful for work “on the go” (e.g., highlighting dense / bright phases), it is recommended to rather use a more powerful image program (Photoshop, ImageJ…) for this.

5.4) Spectral imaging

Acquisition of a spectral image, or hyperspectral mapping, is a very useful feature for a complex intermixture of phases that are difficult to dissociate. It rapidly scans over an area of interest to reveal the concentration of the major elements in each phase. At the end, the resulting image is actually a data-cube with a complete EDS spectrum at each pixel. The classical counting time on each pixel for one pass is usually around 10 to 50 µsec; this is 3 orders of magnitude faster than WDS mapping (usually 10-40 msec). Due to this, the signal collected is very week, often with “peak” reaching just barely 10 or 20 counts. Do not expect miracle in term of element mapping with this technique. You will need a very long acquisition time to be able to see some subtle variation of composition.

The power of this spectral imaging tool resides in its principal component analysis (PCA) that allows to differentiate each major phase, even with a very low count rate. Whereas this technique is very appealing, you
should be aware that (a) it can be time consuming (several minutes), and (b) it will produce a LOT of data in no time (a small map is easily 200-500 MB).

1) Ensure you are in the right Project folder. Change if necessary.
2) In the control pane:
   a) Click on “Spectral Imaging”.
   b) Type in the sample name (e.g., “MySample area1 Px1”; spaces are allowed).
   c) Click on “Electron Image Setup” (gear-like button aside the “Start Image”) and adjust the acquisition parameters for the image. A quick image (fastest) with 2 frames at 1024 pixels is totally appropriate.
   d) Click on “Experiment Setup” (other gear-like button aside the “Start Spectrum”) and adjust the acquisition parameters: live time, max count, cutoffs, and time constant (rate).
3) On the microprobe instrument, in PC_SEM, move to the area of interest.
4) Remove the Faraday cup and locate your area of interest.
5) Choose BSE (COMPO) mode and adjust the magnification to fully cover the area of interest. The magnification should be high enough to be able to target accurately the smallest feature to analyze.
6) Adjust the brightness and contrast to see all the features of interest.
7) Leave the Faraday cup out!
8) Return to Pathfinder, and press “Get Image” to acquire the BSE image. Wait until completion.
9) Click on “Start Map” to start the acquisition. The program will display a spectrum in the bottom part, which represents the full (total) spectrum of the image. The program uses this spectrum to determine which elements are present and will then show the element map for each. If you prefer to display your own set of elements, you must first uncheck the “Auto ID” button under “Spectrum Setting”.
10) Wait until completion; press the “Stop” button if you use an infinite acquisition time or if the map resolution is sufficient.
11) When the acquisition is over or when you press “Stop”, be patient! First the current frame need to be finished. Next the program needs to process and save the data, which can take several minutes depending on the mapping resolution and the total counts collected.
12) After the acquisition, use the File List pane to see each individual acquisition. Use the “Map Processing” to choose what data to show (element, qualitative/semi-quantitative, PCA or phases). When a phase analysis is performed on the map, each phase will be displayed in the File List pane.
13) CLOSE the Faraday cup as soon as the analysis is over.

5.4.1) Tips & data processing

See also the tips on Spectrum and Spectral images (Sections 5.2.1 and 5.3.1). The Spectral Imaging mode has two additional processing options:

- **“Map Processing”** allows you to change the data from element maps, to a series of principal component analysis (PCA) map results, to finally a phase map. The default results are normally shown as “Counts”. The two other modes are…
  - **“Quant”**: you can opt for semi-quantitative elements maps, with data listed as element weight-%, atomic proportion, or net counts. There are other options for the processing quality; more accurate will naturally means more processing time (can reach >10 min…). The “kernel size” will take an average of x pixels to perform the quantification. This option is useful when you have many pixels covering each particle. Of course, the resulting image will be more “blurry”, but should have a higher precision. Keep in mind that the “Quant” results are only SEMI-quantitative in Pathfinder. See more about quantitative EDS-WDS analysis in the next chapter.
  - **“COMPASS (and Phases)”**: This option will consider all data points and determine which pixels in your map are similar, which in turns often results in gorgeous phase maps:
    - Click on COMPASS.
Leave the parameters as set (“Area” and “Calculated…”). Leave the Number of Components to 0 (Auto). Set the low energy cutoff (usually between 100 and 200 eV).

Click “Process” and wait (it can take several minutes). When finished, you should see the PCA results and the button “Phases” should be now available.

Click on “Phases”. Enter the minimum surface percentage (for the smallest / rarest particles) for the phase analysis. The setting “Maximum Intensity” will attempt to attribute a phase to each pixel. The result is a nice map, but the combined EDS spectrum of each pixel attributed to the phases identified often is showing sign of contamination: it will include pixels that are sitting close to another phase, and suggest you elements that should not be present. For a better phase analysis based on the composition of each phase, the setting “X Phase” appears to work better (especially at low count rate).

Click “Auto” and wait. You should see the different phases identified by the software.

“Image Filters” is not available at CU Boulder (software option not purchased).

5.5) Linescan

Sorry, this part of the manual is NOT AVAILABLE YET... It works pretty similarly to the Point ID mode, though (get an image, and select a line to extract the variation of one or more elements along this line). Refer to the Thermo Pathfinder manual for more information.

5.6) Particle analysis

Sorry, this part of the manual is NOT AVAILABLE YET... This part of the software has not been fully tested yet. Refer to the Thermo Pathfinder manual for more information.

5.7) File structure & data export

The easiest way to export your data is to select the data (Spectrum, Point ID, or Spectral Imaging) and click on the icon “Word” or “PowerPoint” in the button bar. The data will automatically be exported to Word (or PowerPoint). If you want to append more data to the same Word (or PowerPoint) document, leave the document open, select the next data to export, and click again the “Word” (or “PowerPoint”) export button. To create a new export file, close the Word (or PowerPoint) document; your next export will be in a new file.

In Point ID or Spectral Imaging mode, you can export the electron image using the menu “File > Import / Export > Export Image as Full-Res TIF (or as Bitmap)”. In Spectral Imaging mode, data can be exported as CSV file (each element map, PCA map, or phase map is exported as a single CSV file containing the intensity at each (X,Y) pixel coordinate.

With the exception of the Spectral Imaging, most files created by Pathfinder are actually text file. They can be open with a text editor (do NOT modify these files!), others are actually “hidden” TIF image files. If you navigate to your Project folder, and depending on what analysis you ran, you will find…

- **Files *.EMSA:** These files are pure text files containing the data from a single spectrum, with the detector information and acquisition setting, followed by the EDS data after (energy vs. counts). Use this file to plot back an EDS spectrum in Excel, or to check the acquisition conditions.

- **Folder *.PS.EDS:** This folder contains the raw data of one Point ID acquisition:
  - Files *.PSMSA are like EMSA files, i.e. spectrum files from the individual point or area acquired in this Point ID acquisition.
• File *.PSREF is the electron image file. Despite its unusual extension, this is a TIF image file. You can duplicate this file and change (or add) the extension “.TIF”, and you should be able to open it with your favorite image editor (Photoshop, ImageJ, GIMP…).

✧ Folder *.MAP.EDS
• File *.PCSA are like EMSA files, i.e. spectrum files from the individual phase identified.
• File *.PCMA are image file from the phases. Despite its unusual extension, this is a TIF image file. You can duplicate this file and change (or add) the extension “.TIF”, and you should be able to open it with your favorite image editor (Photoshop, ImageJ, GIMP…).
• File .SI is the binary file containing all data from the Spectral Imaging. This file is often the heavy-lift of your EDS analysis, with several 100 MB (if not 1-2 GB) per SI file.

✧ File “Pathfinder Lock.txt”: this file will only exist when this project is currently in use. It prevents another user to use this folder to save his/her data (a software safeguard…). If this file exists, you will not be able to open the project during offline reprocessing. To solve this issue, delete this file.

✧ Other files not mentioned here: don’t touch them, required by the software.
6) Quantitative analysis with “Probe for EPMA”
7) Element mapping with “Probe Image”

Probe Image is normally recommended to acquire quantitative element maps. To obtain quantitative images, you will need to acquire not only your maps, but also the standard. It is therefore recommended to first prepare a mapping setup with Probe for EPMA, acquire the standards with this setup, and then run the image acquisition.

Currently Probe Image can only offer WDS mapping. However, we hope that combined EDS-WDS mapping with Probe Image will be soon possible. In the meantime, qualitative combined EDS-WDS maps can be acquired with the Thermo EDS software “Pathfinder” and the 5-WDS input (see Chapter 5).

7.1) Preparing a map setup (Probe for EPMA)

We assume here you know which elements you need to map. A first step is to prepare your mapping setup in Probe for EPMA, and determine which elements is defined on which spectrometer. Once this setup is ready, it can be used to peak the element (find the exact X-ray position line) and to easily set up the element conditions in Probe Image.

If you intend to quantify your maps, you will have to acquire data with Probe for EPMA on standards for elements standardizations (count rates on standards), and for calibration of the MAN background curves. This standardization will be required when reprocessing the data with CalcImage (see Chapter 8).

NOTE: For more information about the use of Probe for EPMA, refer to Chapter 6; only the essential steps are reminded in the following.

7.1.1) Element setting & standardization

1) Open Probe for EPMA and create a new file.
2) Open Acquire! and click “New Sample Setup”.
3) Enter a generic name for your setup, not sample-related (e.g., “Map setup serpentinite”).
4) Optional: choose to reload an existing setup from another MDB file by clicking on “File Setup” and navigating to the MDB file that contains the mapping setup you need.
5) Click OK in the New Sample Setup window.
6) Click on “Elements/Cations”, enter the list of elements you need to map with the appropriate parameters (see Fig. 7-1, step 1): a) The spectrometer and the monochromator;
   b) The peak position (use the default value first, peaking will be done next);
   c) The PHA setting (click the “Calculate Empirical PHA” button).
   d) The background(s), if applicable (required for quantitative analysis or for net counts):
      i) It is recommended to use the MAN background correction by selecting the radio button “MAN” in the Background Type for each element in the Element/Cation Properties window. This technique is totally appropriate for major and minor elements down to 1000 ppm or better, which is probably far better than the sensitivity of your map data. See more about the MAN background technique in Chapter 6.
      ii) For higher accuracy you might want to acquire either one or two background images. Keep in mind this will double (or triple) your total mapping time as a second (or third) pass will be required for each element. To use it, enter the right value for the low and/or high background.
   You will be able to select the low and/or high background map acquisition in Probe Image.
   e) Other parameters can be left to their default value.
7) Peak on the required element:
   a) Move to a standard containing the element to peak. Ensure the Z-stage is focused.
   b) Click on “Peaking” (see Fig. 7-1, step 2):
      i) Select the element(s) to peak in the standard. For multiple element in the same standard click
         on a first element, hold Ctrl, and click on additional element(s) to peak.
      ii) Select the peaking options. Recommended: dual Gaussian-maxima without PHA scan.
      iii) Click on “Start Peaking”. Close the peaking window when done.
   c) Repeat with the next standard / set of elements until you have peaked all elements.

   **NOTE:** if you have many elements to peak, you can also run the peaking in automated mode, in which
   case you will also need to update the X-Y-Z position for the standards to be analyzed (see more about
   automated peaking in Chapter 6).

The following is only applicable, **if you need quantitative analysis.** Although this can be done after your
maps, it is recommended to run it before running your maps, and run it a second time after if a problem occurs
(e.g., spectrometer reproducibility issue). You will need at least 1 hour of calibration time for 5 elements.

8) Click on “Standard Assignments”:
   a) Click on “Add/Remove Standards” and add (or remove) the set of standards you may need (or not),
      either for peaking purpose, for standardization, or for MAN background fitting (only required for
      quantification). Note that if you have recalled a setup from a previously existing file, the set of
      standards used in this past run will automatically be loaded in your new run.
   b) Close the Add/Remove Standard window.
   c) Click on each element to assign the appropriate standard (and peak interference, if applicable).
   d) Click OK in “Standard Assignments”.

9) Define the analytical conditions to be used for the standardization (**NOT the mapping conditions!**),
   usually 20 nA and 10 µm is appropriate.

10) Define the counting time for each element; 20 to 30 seconds is usually enough.

11) If required, go through additional software options; you do not need to acquire EDS spectrum, at least
    not until we have the combined EDS-WDS mapping implemented…

12) Open Analyze! Window, and select the map setup you have created (see 3 above). Click “Add to
    Setups”. The mapping setup is now available for automation work and for maps quantification.

13) Acquire the required data in your standards:
   a) You must have at least one standard for each element to be mapped. Ensure to choose a standard
      that has more of the highest element weight-% you aim to measure, and ideally a standard that is
      the closest in term of density and structure / composition.
   b) If you aim to use the MAN background correction, you must collect data in at least 3-4 standards
      (strict minimum, 5-6 is already better…). In order to obtain an accurate fit, each of these standards
      for the MAN background should NOT contain the element to map and should NOT show any peak
      interference at the position of interest.

As an example, we will consider the acquisition of 10 elements in TWO passes: (1) Mg, Al, Ca, Cr, Fe
and (2) Si, Na, Cl, Ti, Mn (all Kα lines). We will therefore need a set of two TAP monochromators for Mg,
Si, Al and Na, two PETs for Ca, Cl, Cr and Ti, and one LiF for Fe and Mn; see Figure 7-1 for an example of
this map setup in Probe for EPMA. Both passes use exactly the same crystal setup, and no crystal flip is
required. A crystal flip between two map passes is technically possible, but **NOT recommended (spectrometer
reproducibility issue)**. If you only need 5 elements and you can put one element on each spectrometer, a single
pass is naturally sufficient. **Keep in mind that not all spectrometers can accept any elements!** Most of the
time, light elements (Si, Al, Na, Mg…) can only be put on spectrometer 1 and 2 as they require a TAP, whereas
heavier elements (e.g., transition metals) can only be put on spectrometer 3 to 4 as they require an LiF.
Figure 7-1 Preparing a setup for mapping in Probe for EPMA.

**Element PEAKING:**
1) Move to a standard that contains the element(s) to be peaked in large quantity.
2) Find a clean spot and focus the stage.
3) Select one or more elements to peak.
4) Click “Start Peaking”.
5) Repeat until all elements are peaked.

**Analytical conditions for standardization (for quantitative element mapping):** To quantify your element maps, you will need to acquire data in several standards. If this is the case, set up the analytical condition to 20 nA and 10 um, set the count time (20-30 sec), and assign a standard to each element. Refer to the chapter about Probe for EPMA for the standardization procedure.

**Setting up spectrometer(s) to an element:**
1) Select up to 5 elements (one per spectro).  2) Click “Move Selected Elements To On-Peak Positions” to set each spectrometer.

Create a “New Sample Setup”. Enter the elements to be mapped. **Recommended:** choose MAN background for each element.
7.2) Acquiring maps (ProbeImage)

7.2.1) Spatial & analytical resolution, and mapping time

When preparing the acquisition of a map you will have to think about (a) the actual size of the area to be mapped, (b) the desired spatial resolution, and (c) the desired analytical resolution (sensitivity). All these points will affect the total mapping time, and it is common to iteratively change these values due to time constraints.

7.2.1.1) Pixel size, beam size, and analytical resolution

The level of spatial resolution on the final image is expressed as the size of one pixel in µm (= µm/px). You will have to adjust this value depending on the size of the area to map and on the size of the feature to be revealed. Of course, ultimately time constraints might force you to review these values… For detailed map revealing all particles of interest, a minimum of 4 to 9 pixels should ideally cover the smallest particle to ensure at least one pixel is fully within the particle. In other words, the pixel resolution must be 1/2 to 1/3 of the size of the smallest grain or feature to be mapped. For instance, 3-µm wide exsolution lamellae in pyroxene would require a resolution of at least 1.5 to 1.0 µm/px. This rule is not absolute and can be broken in some cases when qualitative results are sufficient; see for instance the full thin section mapping technique in the applications below, which can reveal particles as small as 5 µm despite using a coarse resolution of over 20 µm/px.

The beam size is usually set to equal the pixel size. However, at a pixel size below 2 to 3 µm/px and under certain situations, the electron beam size or the emission volume might be larger than the pixel size. As a result, the map might appear blurrier than usual (oversampling). Pay attention to these rules:

- High current (>100 nA) are often required for mapping, and will increase the beam size;
- Lower voltage increases the beam size;
- The analytical volume is often larger than a sphere of 1 µm diameter…
  - Lower density materials will allow electron to penetrate deeper;
  - Higher acceleration voltage will increase the analytical volume;
  - Lower energy X-ray (higher overvoltage) will have a larger excitation volume.

7.2.1.2) Dwell time

The dwell time (= time spent on each pixel) is set based on the desired level of sensitivity, which is different for each element to be mapped (different overvoltage and spectrometer efficiency). Depending on the spectrometer and X-ray line you are looking at, one element will have a higher count rate than another. You will have to decide the dwell time based on the most important element for you, and especially the ones with a low count rate. In the most common situation (15 keV, ≥50 nA) a dwell time of 20-30 msec is sufficient for mapping major elements, whereas a dwell time of >50 msec is recommended for minor elements. Trace element mapping is possible in theory, but not recommended as it is time consuming (10+ hours).

A more rigorous way to think about the dwell time is to estimate how many counts you can expect. You can for instance compare the X-ray count rate reached on a material (standard) of known concentration with the expected composition in your unknown (wt-% range) to estimate the number of counts you could receive in one pixel of your map using the (very short) mapping count time. This estimation is inaccurate, notably because it does not take into account of the different absorption effect in your sample vs. the standard. A first order evaluation of the achievable precision is obtained by calculating a 1-sigma standard deviation using Poisson statistics: \( \frac{(N)^{0.5}}{N} \) (N = total number of counts). The program CalcZAF has a more robust routine to model the detection limit in a similar way (see menu “Run > Model Detection Limits”).
7.2.1.3) Total counting time

The total time depends on the total number of pixels and the dwell time. The total number of pixels is usually set at a value < 1 to 2 million pixels due to time constraints. Mapping time for major to minor elements can vary largely depending on the mapping area and the expected level of sensitivity:

- Small grain (50 µm) can be mapped in 5-30 min depending on the required sensitivity.
- Qualitative work on major element over a few millimeters can be done in 1-2 hours.
- mm-sized areas with µm-size spatial resolution will take 2-3 hours (or more for higher sensitivity).
- Full thin section scan to reveal all accessory phases can usually be done in 4-6 hours at &ge;25 µm/px.

At the end, you will likely have to cut on the dwell time and/or on the size of the mapping area in order to reach a reasonable mapping time. Use the mapping tool at http://cub.geoloweb.ch/?page=xraymap_calculator to estimate the total mapping time. There is a software delay on each line (variable), due to some software overhead time. Therefore, it is common to assume an extra 3 to 5 seconds per mapped line.

See also the example of applications in Section 7.3.

7.2.2) Preparing a map acquisition with Probe Image

1) Open ProbeImage.
2) Click on menu “Setup > Acquisitions…”.
3) Delete all pre-existing maps in the top-right panel (“Acquisition samples”). Do NOT use the “Delete All” button a bug in Probe Image will cause trouble setting your elements later. Rather, click-and-drag to select all but ONE entry, and click several times “Delete” until there is only one entry left.
4) Click on the sample name to enter the name of your first map. It is recommended to include the sample ID, an identification for the area to map, and (if applicable) the pass number (for mapping of >5 elements). Keep your sample name SHORT (e.g., “JMA01-b area3 #1”!)
5) Move the stage to the area of interest (center position) to visually estimate the area to be mapped.
6) Ensure the stage is focused: manual focus first (if necessary), then auto-focusing with the “AF” button.
7) Define visually (using the BSE / SE image) the area to be map.
8) Follow then the instructions in Section 7.2.3 for setting a mapping area. Use a beam map setting only for areas &le;50-100 µm wide (§7.2.3.1), otherwise use the stage map center or 2-pts (§7.2.3.2 or 7.2.3.3).

TIP: If you need to set additional maps, click the “Insert After” (or “...Before”) button. This button will automatically duplicate the last entry (below or above the selection). Therefore, if you intend to map several areas with the same element settings, it is good practice to do this AFTER having set the first map! Doing so, you will just need to adjust the stage coordinate and the column conditions (beam diameter or current).

7.2.3) Setting up the mapping area

7.2.3.1) Beam scan map

1) Select the radio button “Beam”.
2) Adjust the stage & magnification to have the BSE/SE image covering exactly the area to be mapped.
3) Focus the Z-stage (manual focus if necessary, then AF).
4) Click on the “Read X,Y,Z” button to update the stage coordinate.
5) Click on the “Read” button aside the magnification to read the current magnification. This will define the largest dimension of the map in µm (as shown below the magnification reading).
6) Adjust the image size in pixels; you can map with any kind of pixel ratio for X and Y. The actual size of one pixel is calculated by dividing the dimension of the map with the corresponding number of pixel.
For instance, if a mapped area is 25 x 40 micron, and the map size is set to 50 x 80 pixels, then the pixel size will be 40 μm / 80 pixels = 0.5 μm/px. To double this resolution, the map is set at 100 x 160 pixels. 7) To avoid defocusing issues, ensure the map size is less than 50 μm to avoid strong defocusing issue on the edges.

7.2.3.2) Stage scan map – Center

1) Select the radio button “Stage Ctr”.
2) Adjust the stage and magnification to have the BSE/SE image covering the area to be mapped. Use the “Rulers” button in the top of PC_SEM (diagonal measurement) to determine the size of the area to map.
3) Focus the Z-stage.
4) Set the magnification to cover the area to be mapped.
5) Click on the “Read X,Y,Z” button to update the stage coordinate.
6) Click on the “Read” button aside the magnification to read the current magnification.
7) Adjust the Image Size (pixels) and the Pixel size (in μm) to constrain the size of the area to be mapped.

7.2.3.3) Stage scan map – Two-point

1) Select the radio button “Stage 2pts”.
2) Move the stage to one of the corner of the area to be mapped.
3) Focus the Z-stage.
4) Click on “Read X,Y,Z” to update the X, Y and all four Z-values (one for each corner). Note that clicking on “Read X,Y” will only update X and Y, NOT the Z-values; use this button for fine re-adjustment.
5) Move the stage to the opposite corner of the area to be mapped.
6) Focus the Z-stage.
7) Click on “Ready X2, Y2” to register the 2nd corner of your map.
8) Click sequentially on the buttons Move UL, UR, LL, or LR to move to each corner (UL = upper left, LR = lower right, etc.). For each, ensure the Z-stage is focused. Focus the Z-stage if necessary, and click on the “Read” button situated on the right of the Z(xx) reading.

7.2.4) Choice of elements (WDS Input)

After selecting the area to be mapped, you must define the list of elements to be acquired. This is done in the large panel below the acquisitions parameters window, under the tab “WDS Input”. Although you can enter data manually, it is best practice to use the setting you have created with Probe for EPMA (see Section 7.1.1 and Figure 7-1, step 3), which contains also the peaking of each element:

1) Open Probe for EPMA and the MDB file containing your mapping setup.
2) Open Acquire! and ensure that the last entry (analysis) is corresponding to your map setup with all the elements you need. If not, click on “New Sample Setup” and create a setup containing exactly the set of elements you are mapping. If you have a setup available (but it is not the last analysis), you can also recall this setup in the “New Sample” window.
3) In Acquire! window, click on “Peaking” (same button available also in Automate!).
4) Select the set of 5 elements to be mapped.
5) Click on “Move Selected Elements To On Peak Position”.

It will take a few seconds to a minute to set the spectrometers in position and to set the PHA setting. When done, return to Probe Image, and click on the “Inst. All” button on the right to read the current instrument conditions, and then “Elm. ALL” to display the correct element name.

WARNING: To obtain accurate results, you MUST perform a peaking on a set of standards to find the exact X-ray line positions (see Section 7.1.1).
7.2.5) Analog signal, and column conditions

Under the tab “Analog Inputs”, select one analog signal to be acquired with your map (BSE or SE). Under the tab “Column Conditions”, enter the desired acceleration voltage, beam current and beam size, or choose to use the current instrument settings.

On “PC_SEM”, ensure that the beam alignment is good (reminder: large changes of current and/or voltage might require new beam alignment). Avoid doing the beam alignment on the area to be mapped, as you can potentially damage the area to map!

Finally, before running your map, you must ensure the brightness and contrast is properly adjusted. This adjustment must be done with the light OFF (in OM Monitor, click on the light bulb to switch it OFF), as Probe Image will force switching OFF the light when running the map(s). Move to a representative area to be mapped to adjust the brightness and contrast. If you have multiple maps, check each area, and ensure the brightness and contrast setting is good for all.
7.2.6) Start the acquisition

When you are ready, close the acquisitions setting window.

*Optional but recommended:* Save your acquisition setting in a text file by clicking on menu “File > Save acquisition file…” (file saved with the extension “.prbacq”). Save your acquisition file in the dedicated folder under “C:\UserImages\prbacq files”. This is just a backup in case you need to re-run your maps later due for instance to a hardware failure or some wrong mapping parameter…

To start the mapping acquisition, click on menu “Acquire > Start…” and wait for completion. If you have made a mistake and want to stop the acquisition, click on menu “Acquire > Stop…”. If you stop an acquisition, be extremely patient: the map will need to finish a line (or two) before actually stopping and returning the command to the user.

7.3) Example of mapping applications & settings

7.3.1) Full thin section mapping

Full thin section scan is a technique used to reveal the presence of a certain phase (usually an accessory hard to find on the petrographic microscope) by mapping for a unique element present in large quantity only in this mineral or mineral group (e.g., Zr for zircon, Ce or La for REE phases, P for apatite and monazite, etc.). Despite the use of a large beam, even particles as small as 5 µm can be highlighted providing the targeted element is present in large quantity (>15-20%) with a decent count rate (at least 50-100 cps/nA).

**Example of conditions:**
- **Current:** high to very high (200-350 nA);
- **Dwell time:** short to medium (20-30 msec);
- **Pixel size:** 20-35 µm;
- **Beam size:** Equal to pixel size;
- **Mapping type:** Two-point stage mapping;
- **Area:** Up to 4 cm x 2.5 cm (ca. 1000 x 625 pixels).

**NOTE:** Only 5 elements can be set in a map, and therefore if your goal is to identify ALL particles in your sample and their (qualitative) composition, you should consider another technique such as the QEMSCAN.

7.3.2) Quantitative mapping of simple phases

With the high count-rate of WDS, it is possible to map for major and minor elements in simple phases. The map can be quantified providing all major elements composing the phase to map are analyzed (or specified or constrained). At 15 keV, you can expect to see details in the range of 1-2 µm spatial resolution, and high-quality maps will be at this spatial resolution or better. However, if you are mapping large grains (e.g., centimeter-sized garnet), you might first need a coarse map with >5 µm/px resolution, and then only return to one or more specific (smaller) areas of your grain to map with higher details if necessary. A quick and rough map can be acquired in 30-60 min; high-quality map of several millimeter-sized grains will easily take several hours. The current is usually set to a high value (>50 nA), although you will have to consider potential beam damage (e.g., in carbonate, hydrated phases, alkali-rich phases, etc.).

**Example of conditions:**
- **Current:** high (50-200 nA), lower in very beam sensitive phases (10-20 nA? to be tested…);
- **Dwell time:** short to medium for rough map (20-30 msec), higher for high quality maps (40-60 msec);
- **Pixel size:** depend on grain size: >5 µm for cm-sized area, ≤0.2 µm/px for sub-millimeter area;
\begin{itemize}
  \item **Beam size:** Equal to pixel size when pixel is \( \geq 1 \) \( \mu \text{m}/\text{px} \), or focused beam when pixel is \(< 1 \) \( \mu \text{m} \);
  \item **Mapping type:** Depends on the grain size …
  \begin{itemize}
    \item Two-point stage mapping for large grain not entirely visible at 40x;
    \item Center stage mapping for grain < 3 mm (entirely visible at 40x);
    \item Beam map for very small grains < 50-100 \( \mu \text{m} \). \textit{Watch out for defocusing effects!}
  \end{itemize}
\end{itemize}

### 7.3.3) Quantitative mapping of beam sensitive phases

Beam sensitive materials is a very broad and vague term to describe any material or phase that is susceptible to be damaged by the beam of electron. Damage is essentially caused by heat and the subsequent migration (diffusion) of element and the progressive breaking of bonds (reorganization of the crystal structure or amorphization). Any mineral is susceptible to beam damage, and key is to assess how much energy a specific mineral can sustain before being damaged. The beam damage increases as a function of the time, the beam current. If you double the current, there will be twice more electron in the same activation volume (current dosage is doubled). However, the damage will \textit{decrease} if a larger beam size is used, as it will spread the same amount of electron over a larger surface; doubling the beam diameter will divide the current dosage by 4.

It is possible to \textit{evaluate beam damage by measuring the change of count rate of a major element over time}. Such testing can be time consuming; yet, it can lead to higher accuracy in your data. The data are usually acquired over a certain period of time using the time dependent intensity correction, at a variable counting time, beam current, and beam size. The final results of these tests are usually represented in a plot of the X-ray intensity (in \( \text{cps}/\text{nA} \)) versus the current dosage. Key is to determine the current dosage limit at which beam damage occurs (as seen by a change in count rate). The current dosage is calculated by multiplying the counting time by the current and dividing it by the surface of the beam on the sample. When a focused beam is used, it is better to consider the projection of the analytical volume over the surface of the sample as being the actual “beam size”. In other situation, the surface of the beam is the surface assuming a round beam size (\( = \pi \times \left( \frac{1}{2} \times \text{beam size} \right)^2 \)).

Typical example of beam sensitive materials includes for instance \textit{alkali-rich phase}, \textit{glass}, \textit{carbonate}, \textit{hydrous phases}, \textit{sulfate}, \textit{organic materials}, etc. Depending on the exact composition of the phase, the degree of beam damage can vary. It is therefore important to perform testing in your own samples.

\textbf{WARNING: Do NOT use the laboratory standards to perform testing, unless the lab manager has allowed you to do so! Standards are precious, and sometime rare (cannot be replaced) and expensive ($100-200 each).}

For very beam sensitive phases, it is recommended to use a \textit{time dependent intensity correction (TDI)}. Such a correction can only be done successfully in small grains (50 \( \mu \text{m} \)), as beam scanning is recommended. To enable the TDI correction on a mapping acquisition, you simply have to duplicate several times the same mapping acquisition, and then apply the TDI correction during the reprocessing with CalcImage. Element maps of beam sensitive material that are TDI-corrected might be more accurate and might show a poorer precision, as we are now looking at an extrapolation. However, during the reprocessing, you can also opt to ignore the TDI acquisition, and add all images into one for higher precision.

When mapping very beam sensitive phases (carbonate, sulfate…), you might consider \textit{using metal coating}. Metal coating will help diffusing both the heat and the electric charge faster than carbon coating. At CU, silver (Ag), aluminum (Al), and a little bit of gold (Au) are currently available. If you opt for metal coating, beware that you might have (a) issues of peak interferences from the coating material used, and (b) a stronger absorption effect compared to carbon coating. If you used metal coating and need to quantify your maps, it is recommended to coat the standards at the same time, which requires you contact the lab manager and discuss this idea first: repolishing and recoating the standards is not something we like to do often… However, you can potentially correct for different coating material used between the standards and the unknown by defining the coating material and thickness in standards and unknown in Probe for EPMA.
Example of conditions:

- **Current**: low to very low (5-20 nA, to be tested);
- **Dwell time**: short for very sensitive phases (5-10 msec), higher for high quality maps (20-30 msec);
- **Pixel size**: >5 µm for cm-sized area, ≤ 0.2 µm/px for sub-millimeter area.
  - **Beam size**: Defocus the beam as much as you can to minimize beam damage;
- **Mapping type**:
  - Small grains: acquire a series of 4-5 (or more) sequential maps of the same area in beam scanning mode, and apply the TDI correction when reprocessing the data with CalcImage.
  - Large grains: two-point or Center stage mapping, one pass with the appropriate current & dwell time (no TDI). The TDI correction has not been tested on large area using a stage mapping mode.

---

7.3.4) Semi-quantitative mapping of monazite

For accurate quantitative analysis, it is required to measure or constrain all the major elements. This is a requirement for an accurate matrix correction. However, due to either time constrain and/or hardware limitations, it is not always possible to map for all major element. If the variation of the minor element is what interest you, it is possible to constrain the (approximate) composition by…

- Defining a fixed composition obtained from one or more quantitative analyses in this phase. This is often ideal for phases that shows a relative homogeneity for the major elements.
- Constrain by stoichiometry one or more elements, and specify others.

With this technique, it is for instance possible to obtain semi-quantitative analysis in complex minerals, such as monazite. Monazite is a REE-phosphate and commonly contains over 15 elements near or above 0.5 wt%. The mapping of monazite is notably required prior to dating monazite using the U-Th-Pbtotal dating technique. For dating, we commonly opt to map for the critical elements: Th, U, Y, Si and Ca. These are the major elements substituting for REE and P, and a change in composition in this element is often correlated with a different growth stage, and thus a potentially age difference. Unfortunately, these maps can usually not be quantified, as we are missing the major elements (essentially P and light REE). When reprocessing the maps, it is however possible to fix the composition of P and most REE (Ce, La, Nd, Sm, Pr and Gd). One of the REE (e.g., Ce) can be set to be calculated by difference. Even if the accuracy of the results can be questionable, this technique will allow to compare one-to-one different maps obtained in different samples. Three tests have been performed using different fixed composition (average monazite composition vs. Ce-rich vs. Gd-rich), and the observed variation is within the analytical error.

Example of conditions:

- **Current**: high (50-200 nA), lower in very beam sensitive phases;
- **Dwell time**: high for good quality maps (400-100 msec and more);
- **Pixel size**: Depend on the grain size, but often small (0.2 to 0.5 µm) for 50-100 µm grains.
- **Mapping type**: Beam map is preferable for quick mapping. If necessary, large grains can be mapped in two or more small maps. *Watch out for defocusing effects!* Stage mapping (using the “Stage Center” option) is also possible but often lead to longer acquisition time.

---

7.3.5) Mapping of trace elements

Trace element analysis is usually not recommended, as it often takes many hours. However, if justified, then you will have to consider using a very high current (1 µA or more!) and very long mapping time (8 to 24 hours), which then raise the question of potential beam damage… Some elements will perform better than others. For instance you will get very high count rate, and thus sensitivity when looking for Y La in garnet by using the TAP spectrometer; this X-ray line is near the lower spectrometer limit, and therefore has a very high
count rate. Moreover, the overvoltage for Y La is usually high ($E_{\text{critical}} = 2.08$ keV). However, other elements such as the transition metals after Mn $K\alpha$ at 15 keV will usually have a much lower sensitivity as (a) the overvoltage is often low ($< 2x, E_{\text{critical}}$), and (b) the X-ray lines are on LiF at slightly higher position (> 100 mm). You can evaluate the detection limit you might be able to reach (along with the sensitivity). Refer for instance to the routine in CalcImage (menu “Run > Model Detection Limits”). Best for trace element is still a precise and accurate quantitative analysis (on a spot).
8) Quantitative map treatment with CalcImage

Element maps obtained using Probe Image and the X-ray intensity from the WDS can be quantified at certain conditions. At some point, it will be possible to include signal from EDS in the quantification process, however this is not yet possible. There are three requirements to enable the quantification process.

- **First**, you need all PRBIMG files created by ProbeImage in the mapped area at the end of a WDS mapping acquisition.
- **Second**, a Probe for EPMA file (MDB file) must exist and must contain the X-ray intensity measurements on standards for each mapped element.
- **Third**, the maps must be corrected for background intensity (Bremsstrahlung), either by acquiring another set of element maps at one (or two) background position(s) for each element, or by using the Mean Atomic Number (MAN) background correction (preferred solution).

For accurate map quantification, it is required to include ALL elements in the material to be mapped in order to achieve a total image around 100%. The microprobe has 5 WDS spectrometers, and therefore it is only possible to map 5 elements at a time. For mapping >5 element maps, multiple passes are required. For instance, mapping of feldspars requires at least Si, Al, Ca, Na, and K, which can be done in 1 pass. However, more complex minerals like amphibole might require 2 passes, e.g., to include Fe, Mg, and Mn. If you have to map for minor or trace element(s), you will likely have to use more than one spectrometer (in one pass), or to re-map the same element one or more times (in multiple passes) to improve the signal-to-noise ratio.

In some cases, there will be elements that you cannot measure, such as C and H. For ensuring quantitative accuracy on the measured elements, the content of these missing elements should be estimated as accurately as possible. You have the choice to calculate it by stoichiometry (e.g., oxygen), by constraining its ratio to another element (e.g., carbon in carbonate, with a 1:3 ratio of C:O), by difference, or by a fixed value (element or oxide wt-%). You sometime have to be “creative”. For instance, REE-minerals such as monazite are complex, with often over 20 elements, and not all major elements are mapped. For geological purposes, it is common to map for U, Th, Si, Y, and Ca in monazite, whereas the major elements (REE, P) are not mapped. It is however possible to specify the values for P and several REE, calculate one REE by difference, and set the oxygen by stoichiometry. Tests have been done, and the accuracy on the mapped element looks relatively accurate, although they remain semi-quantitative.

8.1) Required files and data

Each resulting element maps acquired with Probe Image are saved in two file formats: an image output (TIF file), and a raw data file (binary, PRBIMG file). The TIF is helpful for quick observation but is limited by its low quality (0-255 grayscale values, 255 attributed to the maximum intensity). For higher quality images, it is necessary to treat the raw data using the PRBIMG files and the software CalcImage, as described in the following.

**WARNING:** Although the original PRBIMG files should never be altered throughout the process, you should always keep a backup copy of the original files.

For each set of maps to be treated, create a folder containing a copy of the MDB file (from Probe for EPMA). The MDB file is essential to the quantification process and must contain (a) the standardization data, (b) the background acquisition for MAN background correction (if applicable), and (c) a setup that describes the list of elements to be analyzed on which spectrometer. This setup must contain the list of elements you have mapped (in the proper passes order). The options you choose to attribute to this setup in “Element/Cations”, “Calculation Options”, “Standard Assignements” (including attribution of peak interferences), and “Specified Concentration” will be used in CalcImage. These options can be reviewed and
modified during the quantification process. Other options such as the count time and beam current will be taken from the PRBIMG file.

**WARNING:** The numerous files processed with CalcImage will be saved within the folder containing the selected MDB file. It is highly recommended to have ONE specific folder for EACH analyzed area.

### 8.2) Processing element maps

#### 8.2.1) CalcImage: processing the raw intensity maps

CalcImage will calculate the ZAF correction and correct for peak interferences (if applicable) and for background at each individual pixel to properly quantify the element X-ray maps. The results are either corrected intensities (net intensity, k-ratio…), weight-% or atomic proportions. CalcImage uses the raw PRBIMG files (binary) which contains the raw count data. It will also need an MDB file from Probe for EPMA that contains both a setup corresponding to the elements mapped, and the required standardization for each element, along with a defined MAN background correction, if applicable.

For the following, we will assume you have...

1) A set of PRBIMG files in a subfolder in the “User Images” folder, under your own user and session subfolder. Ideally, each individual mapped area should be parsed in one folder.

2) A folder under the “User Data” folder, under your own user/session subfolder, containing a copy of the required MDB file. After the processing, this folder will contain all quantification results from CalcImage. Such a process can easily generate 20+ files, hence the requirement of a specific folder.

#### 8.2.1.1) Pre-processing of TDI files

Beam sensitive materials can be problematic to map, as the use of a high beam current can affect the mapping quality due to element diffusion and destruction of the material. To some extent, it is possible to correct for these effects using a series of maps acquired repeatedly (usually at least 4-5 times) over the same area. Any change in the count rate between the different passes can be corrected, of course only on the first 5 elements acquired… This is usually done in beam mode to enable a fast scanning and to keep the total acquisition time low even after 5 repetitions (usually < 15-30 min).

If you have obtained TDI maps, you must first call a routine in CalcImage to properly treat the TDI files. It is hidden in the menu of the LOG window in CalcImage:

1) In the CalcImage window, choose menu “Window > Log Window”.
2) In the Log window, choose menu “File > Convert Replicate PrbImg Files to TDI (rename and copy to TDI subfolder”.
3) Select the FIRST set of maps acquired in the area, and click OK. If you have only one pass (i.e., most of the time…), click CANCEL when the same explorer window opens again. If you really have two (or more passes), select the FIRST map of the second pass, then click CANCEL when all passes are loaded.
4) This routine will have created a subfolder “TDI” with a specific set of filename that will enable the TDI correction.
5) When you want to process your TDI maps, make sure to select the FIRST TDI map (element, not SE or COMPO image) in the TDI subfolder.

#### 8.2.1.2) Quantification process of PRBIMG files

This section includes two examples: (a) a maximum of 5 elements mapped (= one pass), and (b) 6 or more elements (≥ 2 passes). Some indications are also given for special cases, such as the use of TDI maps. Examples of list of files and folders required for each example is given in Figure 9-1.
Figure 8-1 Example of folder and file structures prior to the quantification of X-ray element maps. Image files are saved under "User Images", whereas the MDB file and the future quantification results are under "User Data". Examples include settings for (a) a 5-element (one pass), and (b) a 10-element mapping (two passes).
To quantify a series of element maps…

1) Open CalcImage.

2) Select menu “Project > Create (new) Project Wizard”, and follow the instructions:

   a) Select the MDB file (working folder) containing the analysis setup and required standardization.

   b) Select the setup corresponding to the set of acquired maps. If the desired setup is not available in CalcImage, ensure that (1) it is defined in the MDB file, and (2) it is included in the list of available setups (select the setup in the “Analyze!” window, and press “Add to Setups”).

   c) Select one (any) PRBIMG file corresponding to an element map. If you have multiple passes (≥5 elements), select an element from the first pass. Do NOT choose a COMPO or SE image!

   d) Click “OK”.

   e) The same window will pop up again…

      i) If you have more than one mapping pass (i.e., ≥5 elements, Fig. 9-1b), select the next PRBIMG file corresponding to an element from the next mapping pass.

      ii) If you have only one (or no more) mapping pass, click “Cancel”.

3) The selected set of images will be loaded in CalcImage. For each element loaded, a GRD file will be created in the MDB folder. This file contains the raw X-Y-Z data (stage coordinate and intensity).

4) Click on menu “Project > Specify Quantitative Parameters!” (see Fig. 9-2) to select the data to be calculated, and to adjust if necessary the analytical conditions.

   a) Verify the proper parameters in the bottom window are correct. If not, your PRBIMG files are most likely corrupted and not usable.

   b) Review and adjust some analytical conditions.

      i) **Calculation Options**: define if your analysis is “elemental” or “oxide” (oxygen by stoichiometry), number of atoms for the Formula Basis calculation, element by difference, or by stoichiometry to another element, etc.

      ii) **Elements/Cations**: used to set up the oxidation state (typically FeO vs Fe2O3) and to review spectrometer parameters (cannot be changed; from MDB file). You can also define a specified element: (a) click on an empty row, (b) type the element name and leave empty (delete) the field “X-Ray Line”; this will automatically toggle the radio button to “specified” and disable all other parameters. Use then the “Specified Concentrations” option to enter a value (see below).

      iii) **Standard Assignments**: specify the standard to use for each element map, along with possible peak interference correction.

      iv) **Specified Concentrations**: enter a fixed value, element or oxide weight-%, to each pixel on the map. To specify an element, it must first be defined as a “specified” element in Elements/Cations.
c) Select the data (checkbox) you want to include in your calculation:
i) **Output Net, Bkg, or k-ratio intensities:** Usually not needed.
ii) **Output Quant Percents:** Export results in elemental weight-% (always active).
iii) **Output Oxide Percents:** **Recommended.** Export results in oxide weight-%.
iv) **Output Atomic Percents:** **Optional.** Export results in atomic proportion (assuming a total of 100 cations + oxygen).
v) **Output Formula Basis:** **Optional.** Use the formula calculation number as defined under “Calculation Options” to calculate an atomic proportion.
vi) **Output Detection Limit & Output Anal. Sensitivity:** **Optional.** Calculate the detection limit and analytical sensitivity on each pixel. If checked, “Do not blank value” will force showing all results of calculation even if beyond the recommended calculation range.
vii) **Output Log Wt. Percent:** **Optional.** May be useful when an element is expected to be a minor element in a mineral, and a major in another.
viii) **Calculate “Totals” Image:** **Recommended.** If all elements are analyzed, the total image should approach 100%, and can thus serve as quality control.
ix) **Calculate Stoichiometric Oxygen Image:** **Recommended.** Generate a map of oxygen calculated by stoichiometry.
x) **Calculate Element by Difference:** **Optional.** If you have set an element by difference.
xii) **SE/BSE:** **Recommended.** If SE or BSE image is available, you can include it in the output.

![Figure 8-2](image-url) "Specify Quantitative Parameters!" window. User must select the data to be calculated with the checkboxes on the right, and setup the analytical conditions (buttons). Recommended checkboxes are shown, but can vary on a case basis.
d) If all analytical conditions are set up properly, click “OK” in the “Specify Quantitative Parameters!” window.

5) Select menu “Project > Output Sample Parameters” to ensure all parameters and required file are properly set up. The log window will appear (sometime hidden behind the main CalcImage window) and a summary of the quantification parameters will be given. If a problem occur, the log window will indicate it at the end in purple or red. Otherwise, some text in blue will state that all is good.

6) Select menu “Project > Calculate Quantitative Images!” to start the quantification process. Depending on the total pixel number, the complexity of the analysis, and the processing power of your computer, the process will take a few minutes to a couple hour. The process often runs a bit faster if the log window is closed and if the main CalcImage window is minimized.

Note that it is possible to open multiple instance of the software CalcImage. You can thus treat multiple maps at the same time, although at some point your computer capability will slow down the process. The list of input and output files is summarized in Figure 9-3.

**Figure 8-3** List of input and output files from CalcImage.
8.2.2) Exporting quantified images

Each image is saved in a GRD file format, which can be read with the program “Grapher”. The easiest and best export option is with the program “Surfer”. Both “Grapher” and “Surfer” are programs from Golden Software (http://www.goldensoftware.com/).

8.2.2.1) Export to Surfer

Once the calculation are done, there are multiple scripts available to automatically export the results in Surfer. Surfer is a plotting tool that offers 3D option suitable for plotting X-Y-Z data such as an element map (stage coordinates + X-ray intensity). For the use of the program Surfer, refer to the corresponding software documentation or the Golden Software website.

At the menu “Project” of CalcImage, you will find several options to open (view) or export your data with Surfer. Each will open a submenu where you can choose which data to be exported (element or oxide weight-%, atomic proportion, detection limit, etc.). Of course, you can only export the data if they do exists (check the presence of the corresponding GRD file in your User Data folder).

- **Output Image Statistics For**: Create a text file with some statistical data on the map (min, max, average, standard deviation...).
- **Convert Quantitative Images To**: Subroutine to calculate endmembers for garnet, olivine and pyroxene, and to calculate age map in monazite with maps from U, Th and Pb.
- **Open Images For Current Project**: Open GRD files for all elements of an output (if existing).
- **Export the Project Grid Files For Presentation Output**: Simple export of all maps in Surfer. By default, 4 plots are included per page. You can change the number of plots per page in the menu Surfer Templates and Options.
- **Export the Project Grid Files For “Slice” Cross Section Output**: Export a line that you draw on your map. The result is a series of cross-section along your map, with an export of the element map, and a plot of the intensity (or weight-%) along that cross-section (one element per page). The routine also generate a DAT file (text file, tabulated values) with the X-Y-Z values for plotting in Excel.
- **Export the Project Grid Files For “Polygon” Cross Section Output**: Export for a polygon extracted from the mapped area. I have limited experience with this output option, but it should allow you to extract, for instance, a specific grain or a domain in a grain within the mapped area.
- **Export the Project Grid Files For “Multiple Strip” Cross Section Output**: Similar to the slice but for multiple lines / cross-sections.

In most case, you will simply use the “Export the Project Grid Files for Presentation Output” options, with 4 or 9 maps on each page. Once the results are exported, you can open the SRF file for further edition in Surfer.

The four export options will all generate a script file (BAS file) and will start the Scripter program of Surfer. This program will execute the script (after confirmation from your side), and export the data into Surfer. For the options “Slice”, “Polygon” and “Multiple Strip”, you will need to create a set of digitize point in Surfer that will be used for the export. Explanations are given in the script routine as a pop-up message with a button “Finished Digitizing”. The steps are summarized below:

1) Select the map.
2) Right-click on the image, and select “Digitize” in the contextual menu.
3) Left-click on the image to create an entry point. The digitized (X, Y) positon will be saved in the Digitize window. Continue clicking to define a two-point (or multiple point line) or a polygon depending on the export option you have selected.
4) Once all points are selected, click in the menu “File > Save As…” in the Digitize window (that little window with the series of digitized (X, Y) coordinates.
5) Name the file “digitized.bln” (default name). Make sure to save it under the folder containing the required GRD files!
6) Click the “Finished Digitizing” button in the Scripter message window.
8.2.2.2) Modification of plot colors and scaling (min/max) in Surfer

Surfer works like Excel; even if you don’t see it there is a set of data linked to this file. Therefore, you can change the limits for the Z-dimension (intensity or weight-%) without affecting the resolution. It is indeed recommended to adjust the values to enhance whatever feature your maps should show. To change the Z-dimension values and color scheme…

1) Click on the plot to modify.
2) In the side bar “Property Manager” (bottom-left), select the tab “General”, and open the “General” property section (click on the + sign).
3) Click on the three dots […] aside the Colors to modify the color palette. In the Colormap window, you can modify the limits of your plot by entering the desired values under “Minimum” or “Maximum” at the bottom of the window. You can also opt to use a logarithmic scaling.
4) Make sure the options “Interpolate pixels” is unchecked. This feature will tend to smoother your data and can potentially hide small but important feature in your map. It is recommended not to apply any filter to the data, unless this is for a good reason…
5) Click on the + of “Hill Shading” and make sure that the “Hill Shading” option is UNchecked. This effect is what makes a topographic map (for instance) interesting by adding a shading effect. However, this effect is absolutely awful on element maps…

There are many more options in Surfer, and I invite you to explore more. However, in most case, the simple modification presented above is the only key one you will need. If you are comparing multiple mapped area to show differences (either between samples or between area of a sample), it is advisable to use a same scale for each element on each mapped area (i.e., set the limits to 30-55% Si, 0-5% Mg, 10-27% Fe… on all mapped area).

8.2.2.3) Exporting the final results as JPG or PDF

It is likely you would like to use the maps in either Illustrator or PowerPoint or Word for a figure in a publication, a presentation, or a document. Surfer has multiple export options available under the menu “File > Export”. A classical JPG export always work, but for work with a vector image software (e.g., Adobe Illustrator), it is recommended to export the plot as “PDF (Vector)”. Surfer offers many more export options.